
最新消息 ……………………………………………………………… 1 

研討會訊息 …………………………………………………………… 2 

資料釋出消息（九十一年七月至十一月） … … … … … … … … … … …  6 

STATA統計軟體探討（二）………………………..………………… 20 

大型資料介紹  

  台灣地區社會變遷基本調查 ……………………………………….. 21 
  政治大學選舉研究中心選舉調查…………………………………….. 23 

世界各國資料庫介紹   

  ZUMA, Center for Survey Research and Methodology. ……………… 25 
  PSID, Panel Study of Income Dynamics………………………….…… 27 

學術調查研究資料庫資料使用及資料提供意見調查 ……………….. 31 

資料整理與檢誤經驗談 – 以 SPSS程式進行邏輯檢查 ………………… 35 

主計處人力資源調查資料背景簡介……………………………….……… 42 

研究方法專題：淺談信度……………………………………………… 46 

資料釋出使用狀況（九十一年七月至十一月） … … … … … … … … … 57 

如何申請資料 ………………………………………………………… 58 

捐贈資料說明 ………………………………………………………… 58 



 

1 

最新消息 

王文心 

「調查研究資料整理與檢誤」研習班即將舉辦 

中央研究院調查研究工作室將於民國九十二年三月三日、四日舉辦「調查研究

資料整理與檢誤」研習班，限於電腦教室的座位數目，該研習班預計只有 110個名

額，將優先提供予執行九十一年度國科會人文及社會科學專題研究計畫時，使用調

查法（以面對面、電話、郵寄問卷進行訪問）之專題研究計畫計畫主持人或助理參

加。 

報名學員若能先熟悉 SPSS 軟體之基本操作，將有助於課程的瞭解，課程內容

將教導學員認識資料庫之功能和資料收藏規格、如何設計過錄碼，以及進行調查資

料不合理值（界外值）、邏輯檢誤與一致性檢核等，並同步安排電腦供學員練習。 

開始進行「台灣地區民意調查資料庫建置計畫」 

新聞性民調資料具有即時反映重大新聞事件中民眾觀點、以及長期記錄政治社

會變遷趨勢的重要特性，為提供更多樣化的調查資料，促進相關資訊整合與應用，

中央研究院調查研究工作室自民國九十一年九月起陸續拜會各大媒體民意調查中

心，希望共同建立台灣地區民意調查資料庫，目前參與該資料庫建置計畫的單位有

TVBS民意調查中心、東森民調中心、以及聯合報民意調查中心（按筆劃順序）。 

在本次計劃中，資料庫將蒐集及開放的資料項目包括：問卷、原始數據資料檔、

欄位定義程式、次數分配結果、新聞稿、加權說明檔等，以便學者取得資料後，即

可著手分析資料。 

「調查研究」期刊第十一期即將出版 

「調查研究」為中央研究院調查研究工作室出版之學術性刊物，除刊登有關調

查研究的學術論文外，另提供近期進行之重要調查研究計畫的簡介，最新一期即將

於近日內出版。 

對內容有興趣者可就近至圖書館查閱或上網瀏覽當期目錄，網址為

http://www.sinica.edu.tw/as/survey/intro_j.html，或電洽：（02）2788-4188分機 506。

本刊亦接受個人訂閱，上述網址中有訂閱方式可供參考。 
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「台灣選舉與民主化調查」--九十年立法委員選舉調查資料公開 

「台灣選舉與民主化調查」（英文名 Taiwan Election and Democratization Study；

TEDS）是一個由國科會政治學門召集人與各校委員共同規劃、跨校會商，以台灣

選舉和台灣政治發展對民眾心理與行為層面的影響，為研究重點的大型調查研究計

畫，其中第一年以九十年立法委員選舉做的調查資料已由政治大學選舉研究中心整

理完畢，並開始接受學術界（不限研究領域）申請資料。 

該計畫問卷設計包括現有選舉研究中最常被運用的核心問題、公開徵求加掛、

以及考量未來與國際接軌所設計的題目。採用分層分段方式抽樣，最後成功樣本共

有 2024 人。中央研究院調查研究工作室「學術調查研究資料庫」的「台灣選舉與

民主化調查」資料為政治大學選舉研究中心所提供，有意使用資料者可向上述兩單

位洽詢。 

研討會訊息 

蔡宜倩 

一、「中華傳播學會2003論文研討會」徵求論文 

主題： 

1. 跨文化典範轉移：境外傳播理論植入中華社會之適用性與華裔學人的貢獻。 

2. 其他社會科學領域，如社會學，心理學，文化研究等對傳播研究之啟示。 

3. 包括原住民傳播及客家族群傳播等少數族裔傳播對主流傳播行為研究的挑

戰。 

4. 其它： 

（1） 凡與傳播學或術有關的論文，均都歡迎。 

（2） 歡迎組織 Panel或Workshop，請先提出構想，以便安排議程。Panel 論

文不列入論文獎評審範圍。 

（3） 投稿論文應未曾發表於中外其它會議或刊物者。 

（4） 「論文提報須知」請詳見中華傳播學會網站 http://ccs.nccu.edu.tw/。 

截止日期： 

1. 論文全文�2003年 2 月 17日截止，以郵戳為憑 。（非台灣地區論文，請

於 2月 20日前寄達） 

2. Panel、Workshop企劃書�2003年 2月 17日截止。 

論文郵寄地址：新竹市大學路 1001號交通大學傳播所「中華傳播學會」 
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研討會日期：2003年 6月 27、28、29日（星期五、六、日） 

研討會地點：中國大陸上海 

二、第十二屆管理教育研討會 

日期：2003年 3月 21日 

主辦單位：國立臺北大學商學院  

主題範圍：本研討會主題涵括所有與管理教育相關的論文，無論是實務導向、理論發

展、實證研究、個案等方面的管理教育相關論文。詳細情形請參考台灣電

子商務學會網站（http://www.atec.org.tw/）。 

聯絡人：因應電子化時代來臨，相關事項請儘量以電子郵件進行聯絡。 

謝錦堂（臺北大學企管系副教授）   shieh@mail.ntpu.edu.tw 

汪志堅（臺北大學資管所助理教授）   wangson@mail.ntpu.edu.tw 

徐  蓁（臺北大學企管系行政助理）   annahsu@mail.ntpu.edu.tw 

（資料來源：台灣電子商務學會網站，http://www.atec.org.tw/） 

三、2003電子商務與數位生活研討會 

研討會日期：2003年 4月 11-12日。 

初步議程：將於 2003年 1月 31日排定。 

主辦單位：臺灣電子商務學會、臺北大學資訊管理研究所、實踐大學資訊管理學

系、台北科大商業自動化與管理所暨經營管理系。 

研討會主題：數位經濟與網路行銷組、企業電子化組、製商整合與產業電子化組、

數位生活與學習組、資訊技術組等各組。 

其他：本研討會所錄取之論文，將擇優推薦「企業管理學報」、「產業論壇」所籌

畫中之特刊中，屬於網路犯罪、謠言、詐騙、倫理、隱私、成癮方面之論

文，將擇優推薦至「資訊、科技與社會」學報。除此之外，將持續徵求願

意共同合作刊登電子商務相關論文之學術期刊或專書，並擇優推薦本會所

錄取之論文。 

研討會總聯絡人： 

汪志堅（臺北大學資管所助理教授）wangson@mail.ntpu.edu.tw 

李瑞元（實踐大學資管系助理教授） maria.lee@mail.scc.edu.tw 

（資料來源：http://www.atec.org.tw/ec2003/main.htm） 
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四、「性別、兒童與社會福利-成長停滯年代下的思考」學術研討會 

日期：2003年 4月 18日至 19日 

主辦單位：台灣社會福利學會、國立中正大學社會福利所 

主題範圍：在台灣社會結構與人口組成急速變遷下，本土原有的福利政策及措施

面臨需重新檢討、調整、甚至開創的局面。其中婚姻、生育、人口結

構變遷，以及外籍人口移入所造成的社會問題等相關社會政策議題深

受各界關注。如能以縱貫的角度深度地探討台灣社會福利制度的變

遷，並以人文歷史的關懷融入未來的社會政策應是深具意涵的。因此

本研討會將綜合人口、兒童、性別的縱貫歷史，作為台灣社會福利制

度變遷下的新思考。 

論文截稿日：2003年 1月 15日前，將中文摘要一千字以內連同學經歷送達：621

嘉義縣民雄鄉中正大學社會福利所轉「性別、兒童與社會福利-成長

停滯年代下的思考」學術研討會籌備委員會。 

聯絡人：陳瑩蓉小姐 

聯絡電話：（05）2720411轉 22115 

傳真：（05）2720810 

E-mail：aswwww@gate.sinica.edu.tw 

（資料來源：台灣社會福利學會網站，http://www.sinica.edu.tw/asct/asw/） 

五、第四屆全國實證經濟學研討會 

研討會日期：2003年 4月 26日及 27日。 

地點：國立東華大學 

主辦單位：國立東華大學經濟學系暨國際經濟研究所、台灣經濟學會。 

研討主題： 

1. 總體經濟 （含成長、景氣循環、貨幣） 與政策相關議題的實證。 

2. 個體經濟（含財政、福利、保險、年金、教育、人口學）與政策議題的實

證。 

3. 產業經濟與政策相關議題的實證。 

4. 醫療經濟（含健保）與政策相關議題的實證。 

5. 勞動經濟與政策相關議題的實證。 

6. 農業經濟（含能源及環境）與政策相關議題的實證。 
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7. 國際經濟（國際金融、貿易與WTO）相關議題的實證。 

8. 財務經濟（含金融市場、財務工程、證券投資、財務管理等）。 

9. 計量經濟（計量方法與經濟統計）及實證相關之研究。 

10. 其他針對政策議題（包括政治經濟學）。 

相關訊息：請至國立東華大學經濟學系網站查詢 

聯絡方式：來稿及有關問題及信件，請聯絡： 

地址：花蓮縣 974壽豐鄉志學村大學路 2段 1號 

國立東華大學經濟學系 

E-mail：econ@mail.ndhu.edu.tw 

TEL：(03)866-2500 轉 24203 或 31202 藍苑菁助教 

FAX：(03)866-2535 

（消息來源：國立東華大學經濟學系網站：http://www.ndhu.edu.tw/%7Edecon/） 

 

六、第十一屆廣告暨公共關係學術與實務研討會 

研討會日期：2003年 5月 2日至 3日 

地點：國立政治大學商學院國際會議廳（台北市文山區指南路二段 64號） 

核心主題：區域化與國際化之廣告與公共關係 

徵稿範圍：新興電子媒體與廣告行銷、消費行為與行銷傳播、競選廣告與政治傳

播、視覺傳播與廣告創意研究、公共關係、研究生論文發表區及其它

與傳播學術相關之論文。本研討會亦歡迎組織 Panel或Workshop，請

先提出構想，以便安排議程。採全文審查，來稿字數請勿超過 10000

字。詳細情形請參考網址：  

http://ad.nccu.edu.tw/resource/conference/2003/2003-solicit.htm  

截稿日期：2003 年 2月 25 日（星期二）。投稿者請備妥相關文件寄至「台北市

116 文山區指南路二段 64 號 第九屆廣告暨公關研討會籌備委員會

收」，以郵戳為憑。 

聯絡人：王惠玲助教，電話：29387176，傳真：29387667，e-mail：nuiling@nccu.edu.tw  

（資料來源：http://ad.nccu.edu.tw/resource/conference/2003/2003-solicit.htm） 
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資料釋出消息（九十一年七月~十一月） 

邱亦秀 

「學術調查研究資料庫」於今年七月至十一月開放釋出的資料，包括：【台灣

地區社會變遷基本調查】四期二次以及【國科會89年度調查研究計畫】共 21筆（社

會學 2筆；心理學 3筆；管理學 6筆；教育學 8筆；區域研究 2筆）。 

【台灣地區社會變遷基本調查】四期二次 

    「台灣地區社會變遷基本調查」由行政院國家科學委員會人文社會科學發展處

在一九八三年推動，由社會科學界研究人員規劃執行。調查的主要目的在經由抽樣

調查研究收集資料提供學術界進行有關社會變遷之研究分析。在基本調查研究的設

計上，是以間隔五年為原則，從事貫時性之調查，以集得可做兩個時間點以上之比

較分析，達到探究社會變遷為重要目標。 

本次調查共有三份問卷，分別有：家庭組（問卷一）、社會問題組（問卷二）

以及失業者問卷（問卷三）。於民國九十年七月至八月期間，針對台灣地區年滿廿

歲以上人口，以分層等機率三階段抽樣方式抽取樣本，進行面對面調查訪問。有關

本次調查各問卷主題、樣本特性、以及已發表的相關論文，請詳見本期通訊第 21

頁之專題介紹。 

 

【國科會89年度調查研究計畫】 

社會學： 

  E89025中華職籃運動參與之預測模式／施致平教授 

  E89044台灣報社記者使用 Internet作為消息來源之研究／王毓莉教授 

心理學： 

  E89026 兩岸三地經理人之工作壓力及健康／陸洛教授 

  E89027 社會認知生涯理論之興趣發展模式研究／田秀蘭教授 

  E89035 代間情感糾結：兩代女性的婚姻與家庭經驗(2/2)／利翠珊教授 

管理學： 

  E89028 市場驅動的組織學習和績效／洪順慶教授 

  E89036 我國企業增進人力彈性之途徑／黃賀教授 

  E89037 個人特性、工作經驗及組織社會化實務對新進人員調適之影響：以管理
碩士為例／溫金豐教授 
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  E89039 網路商場行銷策略與消費者服務價值與滿意度之關聯性實證研究／張國
忠教授 

  E89040 社區中小型產業社會化指標建構與估測探討(1/3)：以金棗產業為例／黃
寶祚教授 

  E89042 網路書店行銷通路選擇之影響因素探討／丁承教授 

教育學： 

  E89029 學校本位管理理論模式之研究／林偉人教授 

  E89030 台灣中部地區高中生公民意識及相關因素之研究／蕭揚基教授 

  E89032 我國體育教師專業能力指標建構之研究／許義雄教授 

  E89034 中小學生的金錢概念、態度與消費能力研究 (I)／鍾志從教授 

  E89038 混沌理論在國民小學教師班級經營評鑑指標之建構研究／陳木金教授 

  E89041 中小學校長遴選制度之研究／楊振昇教授 

  E89043 我國大專校院租稅教育規劃新課程內涵與架構之探討研究／賴炎卿教授 

  E89045 私立高教體系與技職體系大學校院教育經費補助模式之研究／曾騰光教
授 

區域研究： 

  E89031 居民對於在社區內增加土地使用類別的意願：以設立保齡球館為例／林
享博教授 

  E89033 集合住宅與其適用公共設施類型對應關係研究：以台中市為例(2/2)／陳
覺惠教授 

 

 

E89025 

計畫名稱（中） 中華職籃運動參與之預測模式 

計畫名稱（英） The Study of Prediction Model of Chinese Basketball Association Participation 

計畫主持人 施致平 

計畫執行單位 國立台灣師範大學體育學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月- 2000年 7月 計畫調查期間  

母群定義  抽樣方法 分層抽樣 

樣本數 493 變項數  

調查方式 面訪 使用統計軟體 SPSS 

計畫摘要 中華職籃 CBA 為國內籃壇帶來盛會，但也因受母企業金融風暴與轉播權利

金糾紛之影響，CBA中止第 5年的球賽。因此，本研究之主要目的乃以 CBA

千禧紀念賽之現場觀眾為受試者，探討觀眾參與職籃之情形，並以羅吉氏迴

歸分析模式篩選影響因子，建立中華職籃參與預測模式。 
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E89025 

關鍵字（中） 中華職籃 CBA、觀賞觀眾、預測模式、觀賞滿意度 

關鍵字（英） Chinese Basketball Association (CBA), Spectator, Predication Model, 
Gratification  

 
 

E89026 

計畫名稱（中） 兩岸三地經理人之工作壓力及健康 

計畫名稱（英） Managerial Stress and Well-being in Taiwan, Hong Kong and Mainland China 

計畫主持人 陸洛 

計畫執行單位 高雄醫學大學行為科學研究所 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 10月 計畫調查期間 1999年 6月 17日–  
2000年 3月 7日 

母群定義 兩岸三地之企業經理人 抽樣方法 立意抽樣 

樣本數 737 變項數 100 

調查方式 面訪 使用統計軟體 SPSS 

摘要 本研究旨在以兩岸三地（台灣、大陸、香港）的跨文化資料，來進一步確立

工作壓力歷程在不同文化（國家或地區）中是否具普遍性。另外，本研究亦

檢視工作掌控感及普遍的控制信念是否為壓力歷程中的調節變項，而其作用

在不同文化中是否又有不同。                                                          

關鍵字（中） 工作壓力、健康、工作滿意 

關鍵字（英） Work Stress, Well-being, Job Satisfaction 

 
 

E89027 

計畫名稱（中） 社會認知生涯理論之興趣發展模式研究 

計畫名稱（英） ASsocial Cognitive Approach to High School Students' Career Interests 

計畫主持人 田秀蘭 

計畫執行單位 國立屏東師範學院初等教育學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 10月 計畫調查期間 
2000年 12月 1日-  
2001年 1月 10日 

母群定義 全國高中學生 抽樣方法 分層抽樣、集叢抽樣 

樣本數 584 變項數 287 
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E89027 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究以社會認知理論為基礎，探討高中學生職業自我效能、結果預期、生

涯阻礙、與其職業興趣、及職業選擇範圍之間的關係。 

關鍵字（中）  

關鍵字（英）  

 
 

E89028 

計畫名稱（中） 市場驅動的組織學習和績效 

計畫名稱（英） Market Driven Organizational Learning and Business Performance 

計畫主持人 洪順慶 

計畫執行單位 政治大學企業管理學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 2000年 4月 10日- 
2000年 4月 30日 

母群定義 

中華徵信所 1999年全國企業排
名資料庫中營收淨額在 6 億以
上的製造業、服務業及全部的
金融業 

抽樣方法  

樣本數 278 變項數 72 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究從市場驅動的觀點闡釋組織學習，探討並驗證前置變數、中介變數與

結果變數之間的關係；另外，將過去學者甚少著墨的組織記憶納入研究，瞭

解其在市場導向組織學習中的重要性。                                  

關鍵字（中） 組織學習、市場驅動、市場導向 

關鍵字（英） Organizational Learning, Market Driven, Market Orientation 

 
 

E89029 

計畫名稱（中） 學校本位管理理論模式之研究 

計畫名稱（英） A Study on the Theoretical Model of School-based Management 

計畫主持人 林偉人 

計畫執行單位 私立輔仁大學教育學程中心 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 2000年 3月 –2000年 6月 
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E89029 

母群定義  抽樣方法 分層抽樣 

樣本數 1093 變項數 72 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究旨在建構一套學校本位管理理論模式，作為學校推行學校本位管理的

行動依據，並提供教育行政機關發展與改革學校教育的參考。  

關鍵字（中）  

關鍵字（英） School-based Management, Theoretical Model 

 
 

E89030 

計畫名稱（中） 台灣中部地區高中生公民意識及相關因素之研究 

計畫名稱（英） A Study of Civil Awareness of Senior High Students in Central Taiwan and 
Relevant Factors 

計畫主持人 蕭揚基 

計畫執行單位 大葉大學共同教學中心 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 2000年 5月 15日- 
2000年 6月 15日 

母群定義 

台灣中部地區 (台中縣、南投
縣、彰化縣、台中市) 高中公立
高中日間部普通班在學學生為
研究對象 

抽樣方法 分層抽樣、叢集抽樣 

樣本數 1141 變項數 102 

調查方式 郵寄問卷 使用統計軟體 SAS 

摘要 本研究擬以高中學生為對象，進行公民意識及相關因素的研究，期能達成下

列目的：1、瞭解高中學生的個人特徵和家庭因素；2、探討高中學生個人、

社會背景對其公民意識各層面的影響；3、探討高中學生與家長互動關係對其

公民意識各層面的影響 ；4、探討高中學生的公民意識在各層面上的狀況和

其間相互關係；5、歸納研究結果，提供建議，作為推展公民教育與相關學術

研究之參考。                                 

關鍵字（中） 高中學生、公民教育、公民意識 

關鍵字（英） Senior High Student, Civil Education, Civic Awareness 
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E89031 

計畫名稱（中） 居民對於在社區內增加土地使用類別的意願：以設立保齡球館為例 

計畫名稱（英） Residents' Willingness to Accept a Specific Land Use in Community: A Case 
Study of Bowing Alleys 

計畫主持人 林享博 

計畫執行單位 成功大學都市計劃系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 1998年 12月– 1999年 1月 

母群定義 台南市的保齡球館 抽樣方法 隨機抽樣 

樣本數 497 變項數 35 

調查方式 自填問卷 使用統計軟體 SPSS 

摘要 目前台南市營業中的 10家保齡球館，其中只有 2家領有營業執照，可以

合法地經營，其餘則違法設立在住宅區或公共設施用地。若要使得保齡球

館業者能合法地找到用地，讓業者先與社區協商，在與居民達成相當的共

識，及對社區有具體的回饋後，再允許變更其基地的使用類別，使球館得

以在社區內興建。本研究即在探討影響協商意願的變數。                              

關鍵字（中） 土地使用變更、社區、協商、保齡球館、logit模型 

關鍵字（英） Land Use Variance, Community, Negotiation, Bowling Alleys, Logit Model 

 
 

E89032 

計畫名稱（中） 我國體育教師專業能力指標建構之研究 

計畫名稱（英）  

計畫主持人 許義雄 

計畫執行單位 台灣師範大學體育學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間  

母群定義 台灣地區（含台北市、高雄市）
公私立中小學體育老師 

抽樣方法 隨機抽樣 

樣本數 545 變項數 81 

調查方式 郵寄問卷 使用統計軟體 SAS 

摘要 本研究之主要目的有三：（一）確立我國體育教師專業能力項目；（二）瞭解

我國體育教師對體育教師專業能力程度差異之看法；（三）依研究結果，提出

建議，以供教育主管機關及師範院校提升體育師資培育水準之參考。        

關鍵字（中） 體育、教師專業、專業能力 
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E89032 

關鍵字（英）  

 
 

E89033 

計畫名稱（中） 集合住宅與其適用公共設施類型對應關係研究-以台中市為例 

計畫名稱（英） The Proper Typological Relationship between Condominiums and Its Common 
Facilities 

計畫主持人 陳覺惠 

計畫執行單位 東海大學建築系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 2000年 1月 –2000年 7月 

母群定義 台中市已登記管理委員會之集
合住宅社區 

抽樣方法 普查 

樣本數 287 變項數 180 

調查方式 電訪 使用統計軟體 SPSS 

摘要 近 10餘年來建商常以高品質、多元化公共設施內容做為行銷的訴求，但所提

供設施往往未能契合社區（與住戶）的需求，反常成為社區管理上的困擾與

財務負擔。基此認知，本計畫係以台中市為研究地區，經由相關業者訪談，

社區問卷調查，設備修繕費用模擬等三種途徑，由設施需求能力、設施供給

成本、及效益評估三個角度，交叉檢視當前集合住宅公設供需與使用管理的

議題，並藉由對不同類型案例在公設負擔能力，需求傾向等的異同比較，試

圖建構集合住宅類型與其公共設施規劃的適宜對應關係。 

關鍵字（中） 集合住宅、使用維護、公共設施、台中、評估、類型 

關鍵字（英） Facility Management, Housing Maintenance, Condominiums, HousingTypology, 
Taichung  

 
 

E89034 

計畫名稱（中） 中小學生的金錢概念、態度、與消費能力研究（I）：小學生的金錢概念、態
度、與消費能力研究 

計畫名稱（英） Children's Development of Monetary Concepts, Attitudes and Skills 

計畫主持人 鍾志從 

計畫執行單位 國立台灣師範大學家政教育學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 2000年 3月 - 2000年 4月 

母群定義 全國小學生 抽樣方法 集叢抽樣 
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E89034 

樣本數 2404 變項數 70 

調查方式 自填問卷 使用統計軟體 SPSS 

摘要 本研究旨在了解我國小學生的金錢概念、態度、與消費能力的發展情形，並

探討影響小學生的金錢概念、態度、與消費能力發展的可能因素。                                                          

關鍵字（中） 小學生、金錢概念、金錢態度、金錢消費能力 

關鍵字（英） Elementary Schoolers, Monetary Concepts, Monetary Attitudes, Monetary Skills 

 
 

E89035 

計畫名稱（中） 代間情感糾結：兩代女性的婚姻與家庭經驗(2/2) 

計畫名稱（英） Intergenerational Emotional Complexes - Marriage and Family Experiences of 
Women in Two Generations （2/2） 

計畫主持人 利翠珊 

計畫執行單位 輔仁大學生活應用科學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 10月 計畫調查期間 2000年 1月 – 2000年 7月 

母群定義 台灣北部中生代已婚女性 抽樣方法 配額抽樣 

樣本數 600 變項數 169 

調查方式 自填問卷 使用統計軟體 SPSS 

摘要 本研究為『代間情感糾結-兩代女性的婚姻與家庭經驗』 研究的第二階段，

主要的目的在探討兩代女性家庭生活經驗中所產生的情感糾結。研究者認

為，已婚成年女性與母親之間的情感，及與婆婆的角色關係，會使其個人界

域產生混淆，而產生代間情感糾結。                                                                                                                                            

關鍵字（中） 代間、家庭系統、愛憎、罪咎 

關鍵字（英） Intergenerational, Family System, Affection, Ambivalence, Guilt 

 
 

E89036 

計畫名稱（中） 我國企業增進人力彈性之途徑 

計畫名稱（英） A study of Approaches to Enhancing Workforce Flexibility for Taiwan Companies 

計畫主持人 黃賀 

計畫執行單位 國立中山大學企業管理學系 經費補助單位 行政院國家科學委員會 
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E89036 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 1999年 10月 1日- 
1999年 10月 31日 

母群定義 天下雜誌(民國八十七年)所
列之 100大製造業 

抽樣方法 機率抽樣、系統抽樣 

樣本數 62 變項數 145 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究檢驗台灣大型製造業的人力資源管理實務對其人力運用彈性的影響。

就一千大製造業隨機抽取一百家進行結構化問卷調查，從回收的六十二份問

卷的因素分析，可將我國製造業與人力彈性有關的人事政策分為九個構面。                                                                           

關鍵字（中） 人力彈性、薪酬差距、目標管理 

關鍵字（英） Organizational Flexibility, Workforce Flexibility, Adaptability, HRM Practice 

 
 

E89037 

計畫名稱（中） 個人特性、工作經驗及組織社會化實務對新進人員調適之影響：以管理碩士
為例 

計畫名稱（英） Organizational Socialization Practices on the New-Comer's Adjustment: Cases of 
the MBAs 

計畫主持人 溫金豐 

計畫執行單位 國立中正大學勞工關係學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 1999年 5月 1日- 
2000年 6月 15日 

母群定義 
剛畢業的管理碩士 (MBA 學
位)，1999年 6-8月進入企業服
務者 

抽樣方法 先由各研究所取得畢業生名
單，經同意後調查 

樣本數 102 變項數 98 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究為縱斷性研究，將以剛畢業之管理碩士為研究對象，進行兩次的問卷

調查，藉由本研究的結果，一方面學術界可以瞭解個人的特性及工作經驗對

新進人員調適的重要性，以做為甄選學生及課程設計之參考；另一方面，可

以讓企業體認到他們在專業管理人才培養過程的重要角色，讓他們瞭解在新

進管理碩士進入組織時應該實施哪些社會化實務及如何選才，才能讓這些人

才快速發揮潛能；這個研究結果對於管理學術界與實務界的銜接，會有很大

的助益。   

關鍵字（中） 新進人員調適、組織社會化、工作經驗 

關鍵字（英） Newcomer Adjustment, Organizational Socialization, Work Experience 
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E89038 

計畫名稱（中） 混沌理論在國民小學教師班級經營評鑑指標之建構研究 

計畫名稱（英）  

計畫主持人 陳木金 

計畫執行單位 國立台灣藝術學院教育學程中心 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 2000年 1月 1日–  
2000年 6月 30日 

母群定義 台北縣市公立國民小學教師 抽樣方法 分層簡單隨機抽樣 

樣本數 716 變項數 90 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究的目的期望從混沌理論的研究來建構一套國民小學教師班級經營評鑑

指標，作為協助國民小學教師有效班級經營之參考。 

關鍵字（中）  

關鍵字（英）  

 
 

E89039 

計畫名稱（中） 網路商場行銷策略與消費者服務價值與滿意度之關聯性實證研究 

計畫名稱（英） The Effects of Marketing Strategies on Consumer Satisfaction and Perceived 
Service Values: the Case of Web Shop 

計畫主持人 張國忠 

計畫執行單位 明新技術學院企業管理系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 1999年 12月 15日- 
2000年 2月 20日 

母群定義 已上網購物之消費者 抽樣方法 簡單隨機抽樣 

樣本數 710 變項數 39 

調查方式 網路問卷調查 使用統計軟體 SAS 

摘要 本研究提出網路商店行銷策略對消費者服務價值認知及滿意度關聯性之概念

架構，其關聯性涉及消費者個人特質及產品涉入程度等潛在調節變項。 

關鍵字（中） 產品涉入，自我形象，自我檢校，認知需求，調節效應 

關鍵字（英） Product Involvement, Self-image, Self-monitoring, Need for Cognition, 
Moderating Effect 
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E89040 

計畫名稱（中） 社區中小型產業社會化指標建構與估測探討(1/3)：以金棗產業為例 

計畫名稱（英） Estimation of the Sustainable Development on the Local Small-Industry (1/3) : the 
Kumquat industry case 

計畫主持人 黃寶祚 

計畫執行單位 國立宜蘭技術學院 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 1999年 9月 1日 –  
1999年 9月 30日 

母群定義 種植金棗之農戶 抽樣方法 分層抽樣 

樣本數 210 變項數 79 

調查方式 網路問卷調查 使用統計軟體 SPSS、EXCEL 

摘要 本文以「產業文化化」與「文化產業化」互動日增之概念，做為規劃在地中

小型產業適區發展之準據，並處理以往以經濟一致性假設為主的分析層級程

序法缺失，即其所產生調查偏誤或呈現分階分級難認定問題。本文以百分百

產區在宜蘭，社會、文化、歷史等跨級屬性均強的金棗產業為例，經由指標

建構及估測結果顯示，「原料」金棗規劃為「加工」金棗、「生態」金棗、「文

化」金棗或「休閒」金棗等，不論屬配合社區活動或者產業集區規劃，各有

明顯不同的前向整合感應度與社會生產力程度。                                                             

關鍵字（中） 金棗產業、社會生產力、指數分析 

關鍵字（英） Kumquat Industries, Social Productivity, Indices Analysis 

 

E89041 

計畫名稱（中） 中小學校長遴選制度之研究 

計畫名稱（英） A Study on The Selection System ofSsecondary and Elmentary Principals 

計畫主持人 楊振昇 

計畫執行單位 國立暨南國際大學教育政策與
行政研究所 

經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間  

母群定義 南投縣、台中縣、台中市、及
彰化縣的國民中小學 

抽樣方法 分層抽樣 

樣本數 1024 變項數 15 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究主要在探討影響我國中小學教育發展十分深遠之校長遴選制度，期能

根據研究結果，提出建言，以供教育行政主管機關之參考。                                                                      
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E89041 

關鍵字（中） 中小學校長、校長遴選制度 

關鍵字（英） Secondary and Elementary School Principals, Principal Selection System 

 
 

E89042 

計畫名稱（中） 網路書店行銷通路選擇之影響因素探討 

計畫名稱（英） Influential Factors for Selecting the Online Bookstore Channel 

計畫主持人 丁承 

計畫執行單位 國立交通大學經營管理研究所 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間 2000年 2月- 2000年 4月 

母群定義 國內外出版商以及國內上網購
書之族群 

抽樣方法 分層抽樣 

樣本數 國內出版商：66／國外出版
商：77／國內消費者：1824 

變項數 78 

調查方式 面訪、網路調查 使用統計軟體 SAS 

摘要 本研究旨在探討出版業者選擇網路書店作為行銷通路時的重要影響因素。我

們考量組織、市場、產品、網路書店功能特性以及環境與競爭等因素構面，

共研擬出 25 具體問卷題項，並針對國內外出版商進行隨機抽樣問卷調查。

另一方面，我們也由消費者的角度探討相關重要因素。  

關鍵字（中） 網路書店、行銷通路、行銷策略 

關鍵字（英） Marketing Channel, Online Bookstore, Marketing Strategy 

 
 

E89043 

計畫名稱（中） 我國大專校院租稅教育規劃新課程內涵與架構之探討研究 

計畫名稱（英） A Study of Exploring a New Paradigm for Tax Education Curriculum in Taiwan 
Higher Education Institutions 

計畫主持人 賴炎卿 

計畫執行單位 逢甲大學財稅學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月 – 2000年 7月 計畫調查期間  

母群定義 

1. 台灣地區大專院校設有
商、管學院之師生 

2. 台灣地區五百大企業 
3. 稅捐機關具大專以上學歷
之從業人員 

抽樣方法 立意抽樣 
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E89043 

樣本數 294 變項數 51 

調查方式 郵寄問卷 使用統計軟體 SPSS 

摘要 本研究參研美國租稅教育模式課程（Model Tax Curriculum）, 美國會計協會

（AAA）所提出從事會計專業的必備知能（AICPA Core Competency 

Framework）以及檢討大學租稅教育課程現況，探討建立大學租稅教課程之新

內涵及架構。本研究設計問卷除了列出主要的 14 種租稅外，另包含 21 項

租稅專業的技能以及 10 項通識知能等課程內涵。 

關鍵字（中） 租稅、租稅教育、課程改革、專業能力、租稅課程 

關鍵字（英） Tax Education, College Program, Course Contents, Curriculum, Model Tax, 
Curriculum, Accounting Education, Competencies 

 
 

E89044 

計畫名稱（中） 台灣報社記者使用 Internet作為消息來源之研究 

計畫名稱（英） Newspaper's Journalists Using Internet as Information Source in Taiwan 

計畫主持人 王毓莉 

計畫執行單位 中國文化大學大眾傳播學系 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月- 2000年 7月 計畫調查期間 
1999年 8月 1日- 
1999年 10月 31日 

母群定義 
以中時報系的中國時報與工商

時報台灣採訪中心為母體，針

對採訪組記者作問卷調查 
抽樣方法 立意抽樣 

樣本數 159 變項數 159 

調查方式 面訪 使用統計軟體 SPSS 

計畫摘要 本計畫希望針對中時報系中的中國時報與工商時報，加以研究，了解報社記

者使用網際網路作為消息來源的現況、比較不同報社屬性，使用網際網路作

為消息來源的情形、比較不同部門屬性，使用網際網路作為消息來源的情形、

比較不同人口變項，使用網際網路作為消息來源的情形。 

關鍵字（中） 電腦輔助新聞報導、資料庫新聞學、線上檢索 

關鍵字（英） Computer-Assisted Reporting, Database Journalism, Online Search 

 
 

E89045 

計畫名稱（中） 私立高教體系與技職體系大學校院教育經費補助模式之研究 
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E89045 

計畫名稱（英） 
A Model Theoretic Study of Educational Subsidies for Private Institutions in the 
Higher Education and Polytechnic Systems 

計畫主持人 曾騰光 

計畫執行單位 朝陽科技大學通識教育中心 經費補助單位 行政院國家科學委員會 

計畫執行期間 1999年 8月- 2000年 7月 計畫調查期間 
2000年 2月 1日- 
2000年 6月 30日 

母群定義 

私立大學、學校之校長、副校

長、主秘、研發長、院長，私

立技職學院、科技大學之校

長、副校長、主秘、研發長、

院長 

抽樣方法 立意抽樣 

樣本數 286 變項數 40 

調查方式 電訪 使用統計軟體 SPSS 

計畫摘要 本研究旨在建構一套適用於當前教育環境的「私立技職體系與高教體系大學

院校補助指標模型」，以作為未來補助私立技職體系與高教體系大學院校教育

經費之參考。本研究希望透過專家、學者參予指標模型及指標細項之評定，

根據專家的豐富知識與經驗做專業判斷，將此判斷結果予以整合，找出一個

合適的指標公式，並將私立高教體系與私立技職體系補助指標模型加以比較

分析。 

關鍵字（中） 私立高教體系、私立技職體系、大學校院、經費補助 

關鍵字（英） 
Private College and University, Educational Subsidies, Higher Education and 
Polytechnic System  

 

本期 21筆【國科會 89年度調查研究計畫】之摘要，限於篇幅僅保留研究目的

部份。完整摘要內容，請參考中央研究院調查研究工作室「學術調查研究資料庫」

網頁。網址： http://www.sinica.edu.tw/as/survey/survey/srda/ 

若欲更進一步瞭解這些資料的相關訊息或申請辦法，請洽資料組助理邱亦秀小

姐。電話：(02)27884188轉 209，或請 E-mail：srda@gate.sinica.edu.tw。 

 

 

 

 

 

更正啟事： 

『學術調查研究資料庫』通訊第二期，”資料釋出消息”（內文 p.15），由淡江大學李麗君
教授執行之國科會 89年度計畫「不同資培育管道學生之教學信念及其改變歷程之研究
(I)」。該計畫之調查方式應為自填問卷，內文中誤植為面訪，特此更正。 
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STATA統計軟體探討 
載入 STATA資料時的技巧 

胡克威 

中央研究院調查研究工作室助研究員 

在 STATA 的使用手冊中，對於安

裝與啟動已有詳細的說明，依循著該手

冊進行安裝後，就可以載入 STATA 的

資料了。但是，在此一安裝方式下，由

於隨機記憶體（RAM）的設定為 1MB，

因此也只能啟動 1MB 大小的資料。若

是資料大於 1MB 時，就會無法讀入該

筆資料，出現如下的警語： 

    no room to add more observations 

此時，使用者只有增加記憶體的容

量，才能讀入資料。對於此一問題，我

們有兩種解決之道：一是在 STATA 中

以指令的方式增加記憶體容量，一是在

視窗環境中增加記憶體容量。詳細作法

如下： 

一、 在 STATA中增加記憶體容量 

在此，我們可以先瞭解該筆資料的

檔案大小，再決定要增加多少記憶體。

查閱該筆資料的檔案大小，可以鍵入 

    d using “path\filename” 

去瞭解到底該筆資料有多少觀察

數（observations）、變項數與檔案大小。

然後，再行修正記憶體的值。例如，再

鍵入上述指令後，發現該筆資料大於

1MB，而使用者欲將記憶體值修正成為

2MB時，指令如下： 

    set mem 2m 

除了上述這種臨時權宜的解決方

式外，另外一種方法，則是在視窗環境

中，直接更改 STATA 的設定。這是在

記憶體足夠的狀況下，比較一勞永逸的

作法。 

二、 在視窗環境中增加記憶體容量 

1. 在「我的電腦」中，點選以 .dta為

副檔名的檔案。 

2. 在「工具」選項中，點選「資料夾

選項」。 

3. 選擇「檔案類型」，選取 dta的副檔

名。 

4. 然後選取下方的「進階」。 

5. 選 取 「 編 輯 」， 然 後 在

c:\stata\wstata.exe /k1000 use “%1”

中，修改 k1000。（例如，若要修改

成為能自動讀取 30MB 的檔案，則

改為 k30000）。 
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系列二  蘇婉雯 

本期介紹調查研究工作室與社會

變遷調查小組甫對外釋出的最新資料

──台灣地區社會變遷基本調查計

畫：第四期第二次。台灣地區社會變遷

基本調查計畫從四期二次開始，便在國

科會社會科學研究中心設置的「社會變

遷基本調查推動委員會」協調下推展。

四期二次為 2001 年 7月到 9月所進行

的調查，此次調查共三份問卷，分別為

家庭組、社會問題組、失業問題組，其

問卷規劃重點如下： 

家庭組： 

可歸納成幾個重點： 

第一， 延續以往社會變遷調查有關家

庭研究的重要議題，包括代間

關係、婦女就業、家庭照顧與

家庭價值。 

第二， 新增以往未曾系統化檢驗之課

題，包括典型的家庭研究主

題，例如：擇偶與親屬網絡；

近年來國內外重視的研究課

題；代間經濟移轉；心理衛生

與家庭照顧。 

第三， 新興之重要家庭現象，如：網

際網路對家庭生活的影響。除

了這些主題之外，各主題之間

的關聯性，亦是設計問卷時考

量的重點。以婦女就業而言，

此次調查著重相關之結構性障

礙，不僅反映在代間關係的家

庭資源方面，也需要考量親屬

網絡的功能與家庭照顧的需

求。 

社會變遷歷年家庭組的問卷有：二

期二次、三期二次，此外在每一期第一

次的綜合性調查亦含有一些家庭功能

方面的問題，可以相互比較。 

社會問題組： 

社會問題是新的主題，但社會變遷基本

調查的過去調查中以及在國科會資助

的社會意向調查（1990-1995）與中研院

社會所推動以電話訪問進行的社會意

向調查（1999 -）中，都包含了一些與

社會問題相關題組。諸如，個人與社會

生活品質的評估、社會問題嚴重性的評

估、色情問題、族群關係、人權問題、

社會福利問題等。在參考過去相關的題

組之後，本計劃在社會問題組問卷規劃

的各項主題包括社會問題整體性評

估、犯罪與治安問題、家庭問題、高科

技發展與社會問題、環境問題與經濟問

題。社會問題組的題目極廣，在社會變

遷與社會意向中多有涉及，可依需要直

接參考資料庫網站中之主題表與問卷

 
台灣地區社會變遷基

本調查計畫 
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內容。 

失業問題組： 

鑑於當前失業問題受人矚目，本期次特

別規劃失業問題問卷，藉以瞭解失業者

前職的工作狀況、尋職意願與過程、相

關福利措施以及整體社會狀況的評

估。問卷設計以社會問卷組中失業問卷

的題目抽出予以擴大，並參考主計處的

失業調查及相關學術研究，使其更完

備。包含教育與語言程度、前職工作狀

況、失業原因、求職狀況、家人失業狀

況、保險與失業給付狀況、台灣就業狀

況評估、個人未來與台灣社會發展之評

估等相關題目。 

調查母體為台灣地區 20 歲以上的

中華民國國民。家庭組與社會問題組的

樣本依分層三段等機率抽樣原則抽取

合格樣本，失業問卷則由家庭組與社會

問題組受訪者本人或其同住家人為失

業者，續問失業者本人的方式來進行。

問卷完成份數為家庭組 1979 份，社會

問題組 2052份，失業問題組 427份（246

人為原樣本受訪者，181 人為原樣本同

住家人，受訪者年齡則不加以限定，未

滿 20 歲者也可以接受訪問，但同住家

人最多不得超過兩位為原則）。 

參與社會變遷的研究人員已於

2002年9月底假中央研究院社會學研究

所舉辦的台灣社會問題研討會中，發表

台灣社會變遷基本調查計畫第四期第

二次調查資料分析的論文，發表人與論

文題目如下所列： 

發表人 論文題目 

蔡德輝、鄧煌發 刑罰觀、社經地位與社區控制對個體被竊形成之影響 

蔡德輝 台灣地區少年加入幫派危險因子之實證研究 

陳玉書 社會治安與犯罪被害恐懼感 

周愫嫻、張耀中 合會行為研究：差距格局理論之驗證 

楊文山 台灣地區家庭暴力之估計與原因 

張榮珍、李朝雄、

鄭泰安 

台灣民眾對自殺與吸毒行為的認知 

瞿海源 民眾對社會問題嚴重性評估的變遷 

莊慧玲、徐美 失業經驗與其特徵對再就業之影響：兼論失業給付之效果 

徐美 失業者特性之研究與勵志工作者效果(Added Worker Effect)之初

探 

張郁雯、林文瑛 升學主義的主觀與客觀：升學機會的認知、期待與現實 

邱耀初 財富、政治意向與性別對環境風險判斷之影響：一個認知的觀點 

伊慶春、吳明燁 婚姻其實不只是婚姻：家庭結構因素對於婚姻滿意度的影響 
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上述研討會論文中作者已同意公

開的文章在中研院社會所網頁之活動

記 錄 中 可 以 找 到 ， 網 址 

http://140.109.196.10/pages/seminar/sp20

02/agenda.htm。此外，台灣地區社會變

遷基本調查的調查資料可以在調查研

究工作室「學術調查研究資料庫」的網

站上提出申請。申請方式、申請資格等

詳細情形請上資料庫網站查詢：

http://www.sinica.edu.tw/as/survey/srda/。 

 

 
政治大學選舉研究中心

選舉調查 

系列二 邱慕慈 

在本通訊第一期中，已介紹了政治

大學選舉研究中心以及其選舉研究計

畫的歷史沿革等。於本期系列二，將再

就其調查訪問的抽樣方式做深入探討： 

抽樣方式，皆採抽取率與單位大小

成 比 例 的 多 階 段 抽 樣 (probability 

proportional to size, PPS)，這個方法大多

用在規模較大的抽樣工作，譬如調查對

象為台灣地區七歲到十二歲的小孩，在

第一階段先抽取一部份鄉鎮市區，第二

階段再自中選的鄉鎮市區抽村里，第三

階段再自中選的村里抽戶或直接抽

人。在抽樣過程中每個階段各單位的中

選機率和那個單位的大小成比例，也就

是單位越大的中選率越高。但到最後結

算下來，所有全體的每一個成員都有相

等的機會被抽中。（洪永泰，2001） 

在調查方法方面，又分為電訪與面

訪兩種方式，在此分別說明電訪與面訪

的抽樣方法： 

一、 電訪抽樣： 

政大選舉研究中心所使用的電話

號碼簿抽樣是以等距抽樣的方式為原

則（等距抽樣：是先把全體總數N除以

樣本數 n，也就是隔 k個抽一個，再用

亂數表自 1 到 k 選一個亂數 R，則

R,R+k,R+2k, … .,R+(n-1)k 等 號 碼 中

選），在抽樣前先統計各地區出版的電

話號碼的欄位、每欄的戶數以及頁數，

統計出電話總數，然後依照訪問地區，

以 PPS之原則，抽出電話號碼。 

由於登錄的電話號碼約佔所有住

宅電話號碼的七成，所以，必須以電話

號碼尾數（最後一位或是最後兩位）以

亂數取代的原則，使得未登錄的住宅用

戶也可中選；而隨機撥號抽樣方法

(random-digit-dialing telephone sample, 

RDD)是在獲得電信局的局碼組合後，

以 PPS的方式，等比例隨機給予不同局

碼後四碼的電話號碼，產生電話樣本，

再進行訪問，這種方法可以解決電話號

碼簿涵蓋率不足的問題，也可以省去每

次訪問前都必須用電話號碼簿不斷抽

樣的麻煩。 

最後，不論採用電話號碼簿抽樣或

是隨機撥號抽樣所抽出的電話用戶，在

進行訪問時，必須由中選的電話用戶中
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決定一位受者。為了維持最基本的機率

抽樣原則，使每一位合格的受訪者都有

中選的機會，以選出具有代表性的受訪

者，必須採用戶中抽樣的程序。 

戶中抽樣的程序是依據洪永泰老

師在「戶中選樣之研究」一書中所提

及，戶中中選機率如下： 

rate(ABCi)=p(A)*p(B)*p(C)*p(i) 

A是戶中人數，B是戶內的組成結構，

C是戶中成員，i是各年齡層 

此公式是根據戶中合格者每人中

選機會相等的原則而設定，必須加上訪

問失敗的因素作修正，也就是調整

p(C)，首先是調到訪問進行之前理論上

使各性別年齡組合的人中選機率和母

體分佈一致，其次再依訪問成功率修

正，把成功率低的人口族群中選機率調

高，以使最後訪問結果和母體結構相

合。 

二、 面訪抽樣： 

以陳義彥教授主持的「選舉行為與

台灣地區的政治民主化（Ⅳ）：從八十

四年立法委員選舉探討」為例說明。此

項研究是在一九九五年六月至一九九

六年七月間所進行的面訪工作，母體定

義為台灣地區（不含金門、馬祖）的全

體合格選民，按內政部民國八十三年的

人口統計，從二十歲以上的人口中，預

定抽取五千人作為訪問對象，估計能成

功訪問約 1200位樣本數。 

該研究以鄉鎮市區為單位，依過去

幾次選舉結果三個主要政黨（國民黨、

民進黨及新黨）得票率以及相關的人文

區位資料，將台灣省 336個鄉鎮市區以

典型相關（canonical analysis）和集群分

析法（cluster analysis），分成 8個集群。

另外北、高兩市因為都市化的特性各自

獨立為一層，所以總共分為 10 層，而

分層之目的，在區分各政黨在鄉鎮區這

一層級的實力。待分層完畢後，依等比

例機率抽樣（PPS）之原則，獨立於各

層中抽樣。除北、高兩市直接分別以里

為第一抽出單位外，台灣省各層之獨立

抽樣，則以鄉鎮市區做為第一抽出單

位，村里為第二抽出單位，人為最終抽

出單位，如此各階段各單位的抽樣，將

使得每個合格樣本的抽取機率保持相

等。 

調查結束後，訪問成功的樣本結構

是否與母體一致？則需作樣本代表性

檢定，當發現成功樣本與母體在若干方

面不一致時，為避免資料分析時造成推

論的偏差，政大選研中心以事後分層

（post-stratification）加權方式來處理，

有關此部分的詳細介紹下期待續。 

參考書目： 

游清鑫、鄭夙芬、陳陸輝（2001），電

訪實務，五南圖書出版。 

洪永泰（2001），戶中選樣之研究，五

南圖書出版。 
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http://www.gesis.org/en/organization/zuma 

陳秋玲 

ZUMA, Center for Survey Research 

and Methodology, 1974年成立於德國的

Mannheim。與另外兩個研究中心：IZ 

(Social Science Information Center) 和

ZA (Central Archive for Empirical Social 

Research)同為 GESIS（German Social 

Infrastructure Services）下的研究機構。

此中心提供諮詢、規劃、評估、執行人

文社會科學之調查研究；蒐集長期性的

社會追蹤調查資料；執行與整理官方統

計調查資料；發展一系列的社會指標用

於社會變遷之調查研究；此外，ZUMA

也致力於研究方法學各方面的發展與

研發，使研究方法更為進步。 

一、 方法學之諮詢與發展 

ZUMA提供協助、建議與評估的諮

詢服務給執行調查研究的學者們，諮詢

項目包括調查研究的每個過程：從研究

設計的理論觀點、問卷調查所需的人力

及物力、經費、收集資料的過程到調查

結果之統計分析。另外一個重要的發展

則是調查方法在技術上的改進與發

展，例如先行預試、拒答、網路調查及

文化差異的調查方法研發。 

二、 社會人口調查 

ZUMA 參與長期性的社會人口調

查，共有五個部門分別負責統籌，分別

是：ALLBUS、ISSP、German Microdata 

Lab、 Income & Expenditure、 Social 

Indicators。 

1. ALLBUS：此部門負責執行兩年

一度的全國性調查研究（1980-2000 

German General Social Survey簡稱

ALLBUS SURVEY），每兩年約

3500 位受訪者接受面訪，自 1980

年，所收藏的資料就持續在增加

中，學者們也十分廣泛的使用這些

資料來做二手分析。ALLBUS的資

料一旦整理完畢後，即馬上對外釋

出。申請資料的方式有線上申請、

郵寄、傳真、或直接由網站下載；

所申請的資料可由 ftp 直接傳送，

或是由 CD-ROM、Diskette 寄送。

資料包括：SPSS資料檔、相關研究

資訊、過錄編碼簿、問卷、研究成

果報告書。ALLBUS的過錄編碼簿

與問卷皆可免費下載；資料檔除了

1994 與 1996 年的部分可免費下載

使用，其他皆須酌量收取費用。 

2. ISSP：此部門負責國際性的社會

調查研究，ZUMA自 1984 年便是
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ISSP（ International Social Survey 

Program）的成立會員，特別著重於

文化比較的國際性調查方法學。

ISSP 每年於世界各地共 38 個國家

進行，有關 ISSP之調查資料現況及

詳細情形請參考 ISSP 的網頁 

http://www.issp.org 

3. German Microdata lab：主要負責

整理與釋出官方統計資料，使得以

往很難取得的政府人口普查資料，

現可供學者或研究單位作二手分

析；ZUMA 的 German Microdata 

Lab(簡稱 GML)是除了德國中央政

府統計處（Federal Statistical Office）

之 外 ， 唯 一 保 有 戶 口 普 查

（micro-censuses）及官方統計資料

庫之機構。GML廣為延攬專家學者

們整理保存這些政府統計資料

（micro-data），所蒐集之資料有：

1962-1997 戶 口 普 查 資 料 

（Microcensuses 1962-1997）；1970

人口與就業普查 (Population and 

Occupation Census1970)；1971社會

經 濟 地 位 普 查 (Microcensus 

Supplementary Survey 1971)；工作

地點與職業普查 (Workplace and 

Occupational Census)； GDR-Data

（包括 1988 年藍領與白領階級使

用社會文化服務之調查、1988年藍

領與白領階級家庭收入調查、

1988-1989 家庭收支所得統計資

料）。 

4. Income & Expenditure：此部門

主要負責諮詢與提供國民所得與

支出的相關統計資料，這些資料

來自官方統計資料或民間企業的

市場調查。所蒐集之資料有 1995

消費者小組座談資料 (1995 

ZUMA consumer panel data)及

LIS 收入所得研究 (Luxembourg 

Income Study)。 

5. Social Indicators：主要負責一般

性的社會變遷趨勢調查，The 

System of Social Indicators for the 

Federal Republic of German 是歷

年來所發展出的一套多樣性的德

國社會指標系統，這些指標同時

也適時地因應社會的變動在更

新；其建立宗旨在提供一套指標

系統與調查資料，以其客觀地了

解社會歷年的變遷，提供社會福

利制度發展之概況，此社會指標

系統也將會開始運用至歐洲其他

國家。目前這個社會趨勢調查的

資料庫共有 400個指標，包括 14

個不同的政治社會層面，涵蓋人

口學、教育學、公共衛生學等領

域。DISI(The Digital Information 

System Social Indicators)是此部

門所研發的資料庫數位化軟體，

此套軟體的特色是使用者可以更

為簡單方便的檢索資料庫，並可

使用英文查詢。社會指標數位化

系統資料庫目前最新版本是2001



世界資料庫介紹 

27 

年二月更新的 2.022 版（DISI 

version2.022），DISI 與社會指標

系統皆可直接由網站免費下載。

此外，這個部門也收藏了德國

1978-1998 年來的社會福利調查

資料 (German Welfare Surveys 

1978-1998)、問卷、研究成果報

告、及相關文獻資料。 

以上五個部門皆有提供詳細的

Service Guide，欲更進一步瞭解各部門

的詳細服務項目，請參考相關網頁 

http://www.gesis.org/en/social_monitoring 

三、 研發部門 

研發部門著重於調查方法與技術

的改進，近來也致力於網路問卷調查的

發展。統計軟體的開發包括TEXTPACK

軟體 (program for computer assisted 

content analysis)，便是針對開放性問題

(open-ended questions)的過錄所研發而

成；ZUMA也有提供線上統計分析軟體

Badason(Basic data analysis system 

on-line)，以 SPSS 資料檔為主，提供簡

單的統計分析結果或統計圖表，單一變

項或雙變項的次數分配表，可免費下載

使 用 ， 有 興 趣 者 ， 請 參 考

http://www.gesis.org/en/software/badason 

四、 研習班與出版品 

出版品大都以德文出版，其中 

ZUMA News Special （第六期除外）則

有英文版，專門紀錄 ZUMA 所參與的

大型研究計畫，及簡介學術研討會議之

發表成果。ZUMA在學術活動方面也相

當活絡，每個月會有 1-2 次不同主題的

研習班(workshop)，及舉辦年度性的學

術研討會；明年七月將舉辦第五屆生活

品質研究國際學術研討會議 (Fifth. 

Conference of the International Society 

for Quality-of-Life Studies: Challenges 

for Quality of Life in the Contemporary 

World. 2003 年 7 月 20-24 日)有關此學

術 會 議 的 詳 細 情 形 ， 請 參 考

http://www.gesis.org/en/social_monitorin

g/social_indicators/Events 

 

 

 

 

http://www.isr.umich.edu/src/psid/ 

蔡宜倩 

Panel Study of Income Dynamics 

(PSID)，是一個自 1968年起由美國密西

根大學調查研究中心（Survey Research 

Center，簡稱 SRC）所執行的長期追蹤

調查。一開始只是一個五年的計劃，用

以研究貧窮及政府改善貧窮政策對人

民經濟福利的效應。而隨著計劃經費不

斷獲得新的挹注，PSID 持續進行每一
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年的調查，並擴充研究中所涵蓋的議

題，迄今已成為起源最早、持續最久的

長期追蹤調查研究之一。 

一、PSID的樣本 

在 1968年一開始的全國性 4802個

家庭樣本中，包括了兩個獨立的機率樣

本：2,000個低收入家庭及 3,000個一般

家庭。由於計畫最初設計的焦點在於瞭

解美國人民的貧窮現象與發展，所以

1968 年的樣本中包含著高比率的低收

入家庭（因此黑人家庭的比率也較

高），在使用這些資料時，需做加權後

方能代表美國實際的人口分布。 

從 PSID 開始對樣本家戶及其成員

進行追蹤調查起，其追蹤原則不僅止於

原本被抽中的家戶，也包括家戶中的成

員離開後所建立的家庭（例如：原家戶

中的小孩長大後所自建的家庭），經過

多年長期調查的累積，PSID 已經從原

本不到5,000個家戶樣本增加至2001年

7,000 個以上家戶的龐大規模，且共蒐

集了 62,000個以上的個人長達 34 年的

資料。也因為家庭與個人資料眾多且繁

複，在資料處理過程中，SRC製作了一

套「家庭及其個別成員級次的資料基

礎 」 （ Family/Individual hierarchical 

Database），便於研究人員瞭解各樣本

戶的家族歷史，進行更多的研究分析。 

為了使樣本更具代表性，PSID 於

1990年抽出 2000個在1968年後來到美

國的拉丁裔移民（包括墨西哥、古巴、

波多黎各等）的家戶樣本，企圖將樣本

代表性涵蓋 1968 年後到美國的新移民

群；但是由於新抽出的樣本中，缺少亞

洲地區移民，加上缺乏足夠的資金，使

得 PSID在 1995年放棄這群拉丁裔移民

家戶，轉而在 1997 年重新抽出 441 個

移民家戶，並將之納入調查行列。PSID

預計至 2005年止，包括原始家戶在內，

將可蒐集到 7,400 個家戶資料。另外，

PSID也在 1997年起將原本每年進行的

資料蒐集工作，改為兩年一次。 

二、主要研究內容 

在 PSID 發展歷程中，早期由聯邦

政府的經濟機會工作室（Office of 

Economic Opportunity)提供贊助，自

1983 年起主要經費來自國家科學基金

會（National Science Foundation, 簡稱

NSF），並加入其他補助來源如：國家老

人 研 究 所 （ National Institute on 

Aging）、國家兒童保健與國民發展研究

所（the National Institute of Child Health 

and Human Development）、保健與人員

服務部的計畫評估助理秘書室（ the 

Office of the Assistant Secretary for 

Planning and Evaluation of the United 

States Department of Health and Human 

Services）、農業部經濟調查服務處（the 

Economic Research Service of the United 

States Department of Agriculture）、住宅

與都市發展部（ the United States 

Department of Housing and Urban 

Development）及勞工部（ the United 
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States Department of Labor）。這些贊助

單位的加入，使得 PSID 的研究內容擴

及到許多重要的領域；但研究的基本設

計與主要內容多年來還是以收入來源

及其多寡、就業、家庭組成的變遷及人

口上的重要事件等為主，以保持前後時

間點上資料間的可比較性。 

PSID 不論在戶長及其配偶的就業

與收入資料或家庭組成變遷的相關訊

息上都做了相當詳盡的蒐集，1985年起

又納入廣泛的家戶內個人生育及婚姻

的回顧史，其他還包括了：居住及飲食

開銷、家務時間與健康狀況等。在家戶

成員中以戶長的資料蒐集最為完整，

1970 年代末才開始蒐集其配偶的資

料，其他家庭成員的資料則較少納入。 

除以上核心資料外，PSID 會不定

時加入一些特殊的主題。從早年的居住

與社區特性、兒童照護、成就動機、在

職訓練及退休規劃等，到後來有關於健

康、親屬關係網絡、財產和教育程度的

問題等。在國家老人研究所提供經費贊

助後，讓 PSID 得以增加一些有關財產

方面及一系列關於 55 歲以上家庭成員

健康方面的議題，其後又增加有關戶長

及其配偶的父母在健康、保健費用及費

用支付來源等題目。 

在 1995 年增加了教育方面的補充

專題，是一個涵蓋 5 歲至 49 歲家庭成

員就學經驗的廣泛議題，屬於回溯性質

的訪問，此外還有一些關於犯罪逮捕及

行為的問題。在 1997年，PSID則加入

一個以 3 歲至 12 歲兒童的發展為主的

補充專題。 

三、資料蒐集、整理與釋出 

在 1968 年至 1972年間，PSID 採

用面對面訪談進行資料蒐集，當時使用

書面問卷及鉛筆記錄的方式完成訪

問。而後為了節省經費開支，1973年開

始讓訪員透過電話跟受訪者進行訪

問，面對面的訪談則僅限於無法使用電

話進行訪問或是沒有電話的受訪者。在

1992 年時，SRC 改變電話訪問的執行

方式，將原本分散於美國各地所進行的

電話訪問，改為於 SRC 集中進行。從

1993年開始，改以電腦輔助電話訪問系

統 （ Computer Assisted Telephone 

Interviewing, CATI）進行電話訪問；在

1995年，進一步嘗試使用電腦輔助個人

訪問系統（Computer Assisted Personal 

Interviewing, CAPI）。經過多年來訪問

方式的更異，目前 PSID 幾乎完全以電

話訪問來完成調查。.以 1999年為例，

有 97.5% 的受訪者是經由電話接受調

查訪問，而所有的訪問資料也已透過電

腦輔助系統完整記錄下來。 

為了維持高回收率，PSID 投注相

當心力：提供給受訪者相關報告書、

15-25 美金的受訪報酬、說服一開始拒

訪的受訪者、當受訪者主動更新聯絡資

料時給予少量金額回饋等，這許多努力

讓 PSID 除前兩年的回收率外，每一年
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都能保持 95％至 97％的高回收率。而

後 PSID 更努力於找回早年流失受訪

者，使得最初樣本家庭的總回收率提高

至將近 60％。 

當資料進行整理，在過程中會經過

兩層的校對程序：人口資料校對

（demographic editing）及經濟資料校對

（economic editing），前者要確保每筆

資料所對應的個人身份編號無誤及受

訪者被問到適當的題組，後者則是檢查

經濟資料的正確性及其完整性。目前這

些資料整理與校對的程序，大多已自動

化和合理化，以其降低成本及加快研究

資料公開的時間。另外，由於資料蒐集

與整理的過程日趨複雜，使得資料蒐集

後至公開檔案間時差拉大，為了讓反映

資料快速公開的需求，PSID 採用兩階

段的檔案釋出時程：先以1968年到1992

年的資料製作資料檔案的初期版，讓使

用者先獲得最新資料；經過幾個月後，

再釋出包括完整資料及變項的資料檔

後期版。 

在資料釋出方面，從一開始 PSID

的資料就是由大學校際政治社會研究

協進會（Inter-University Consortium of 

Political and Social Research, ICPSR）以

磁帶的方式供應，由於 ICPSR的推廣，

使得 PSID 的資料廣被經濟學、社會

學、人口學等社會科學領域研究人員使

用。自 1995年起，PSID的資料檔、文

件、參考文獻和 SAS與 SPSS的資料取

出範例等，都可以經由網路免費提供給

世界各地的使用者。 

四、PSID的新方向 

在 1968 年，大多數的人並不看好

PSID，但現在 PSID建立起龐大的資料

庫，並在有限的資金奧援下帶領新一波

研究計畫。 

經由一些世代移轉、健康和老化、

財富和孩童發展的資料，未來幾年PSID

將可提供資料給對新世代有興趣的研

究人員，以協助他們擬定政策方向及發

展理論。 

另外，對於近來常被提及「新經濟」

議題，許多人認為這與資訊科技有密切

相關，而資訊科技與人們的薪資、工作

時數間相互影響為何，都將是 PSID 未

來關注的重點。 
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學術調查研究資料庫 

資料使用及資料提供意見調查 

林璟鈺

一、前言 

「學術調查研究資料庫」為能瞭

解申請者使用資料的情形並蒐集衍生

著作書目，及國內學界希望資料庫蒐集

的資料類型與提供的服務項目，並調查

對於資料庫提供服務的滿意程度，及受

訪者加入「學術調查研究資料庫」會員

的意願等資料，做為未來改善的參考。 

二、調查實施 

1. 調查對象 

1) 國科會提供之自八十七年度起初

步認定為調查法的計畫主持人。 

2) 本室協辦或已蒐集資料之研究計

畫主持人、共同主持人及相關研

究人員。 

3) 八十九年之後曾向「學術調查研

究資料庫」申請使用資料的人士。 

4) 大專相關科系專任教師，例如：

經濟、心理、教育、管理、政治、

公共衛生等科系與研究所。 

5) 本室工作委員會委員任職之研究

所研究人員。 

2. 調查方式 

本次調查期間自九十一年六月至

九月十一日止，採郵寄問卷方式進行調

查，寄出總數為 3,983 份，回收 1,505

份。扣除因受訪者已經離職、住址錯誤

等被退回的 28 份問卷外，本次調查的

回收率高達 38.1%1。另扣除 5份非因跳

答而未填答（遺漏值）題目超過 26 題

以上者，總計本次成功樣本為1,500位。 

三、調查結果 

1. 整體滿意度 

綜合此次資料使用及資料提供意

見調查結果，本室資料庫的整體表現獲

得大部分受訪者的支持與肯定；舉凡在

釋出資料的行政作業效率、資料取得方

式、工作人員的服務態度等方面，都有

高達八成五以上的受訪者認為滿意；在

資料蒐集項目完整性、資料使用說明易

懂程度、釋出資料的品質、申請手續的

方便性等方面，亦有近七成以上的受訪

者認為滿意；整體而言，有八成一以上

的受訪者對本室資料庫的整體表現感

到滿意。另外在曾經閱讀或參考過資料

使用手冊的受訪者中，亦有八成四的人

認為資料使用手冊對使用者而言是有

幫助的。由此意見調查結果顯示，大部

份受訪者肯同學術調查研究資料庫所

                                                 
1 問卷回收率之計算方式：
1505/(3983-28)*100%=38.1% 
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做的努力，對於資料庫所提供的服務感

到滿意，甚至於非常滿意。 

2. 對資料庫熟悉程度 

從本次調查得知，仍有三成四的受

訪者未曾聽過本室資料庫；在聽過本室

資料庫的受訪者中，僅有二成四的人曾

經申請取得本室資料庫的資料；曾經閱

讀或參考過本室出版的「學術調查研究

資料庫資料使用手冊」亦僅有二成六。

得知本室資料庫的最主要管道仍以執

行國科會研究計畫為主，其次是網際網

路與本室出版品。由上述資料顯示，在

推廣本室資料庫方面仍需繼續努力。 

3. 資料蒐藏與公佈管道 

在資料蒐藏涵蓋領域之廣度、資訊

公佈管道多元化方面，有超過二成以上

的受訪者認為不滿意，甚至於非常不滿

意；另外在資料蒐藏數量、資料庫網頁

內容的豐富性、資料使用親和性、申請

手續的方便性等方面，亦有超過一成二

以上的受訪者認為不滿意。顯示資料庫

在資料蒐藏、資訊公佈管道等方面仍有

改善的空間，應積極蒐集更豐富且更多

元化的調查資料，並及時在網站上呈

現。 

4. 二手資料使用情況 

在所有受訪者當中，有三成二曾經

利用其他來源的二手資料進行分析研

究，其中又以向國內原始資料蒐集人及

國內原始資料蒐集機構取得資料佔多

數，且部分二手資料需透過私人關係取

得，顯示研究者在取得二手資料的來源

及方式上，有一定的限制。因此學術調

查研究資料庫的主要任務，在蒐集台灣

地區重要的調查資料，使之能被妥善保

存，並且免費提供需要者進行資料二次

分析的研究素材，提供相關發表或出版

的書目予使用者參考引用，以發揮調查

資料最大的效益，有重要的貢獻。 

5. 與其他資料庫的比較 

相較於其他資料庫，受訪者認為本

室資料庫在工作人員的服務態度、提供

專業諮詢，協助解答疑難的能力、資料

收費低廉、資料取得時間長短等方面皆

較其他資料庫來得好，其比例高於認為

其他資料庫較好的比例高出許多；但是

在資料蒐集數量多寡及資料蒐集涵蓋

領域廣度二方面，則以其他資料庫較

好。顯示本室資料庫在資料蒐集方面仍

需繼續努力。 

6. 會員制的支持度 

為使學術調查研究資料庫的蒐藏

更充實，制度更臻完善，服務項目更多

元化，目前積極全力投入改造，將陸續

推出多項新增服務項目，包括會員制、

線上資料下載、線上資料分析、網頁全

文檢索、電子報、及發行多項刊物（如

「學術調查研究資料庫」通訊，技術手

冊（如資料彙編；資料整理、檢誤與使

用；大型資料介紹）等，獲得九成的受

訪者表示願意支持本室資料庫的發
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展。另外本室資料庫為提供資料使用者

更周延的服務，計畫將資料申請改為會

員制，會員除現有資料申請外，另增加

線上資料下載、線上資料分析、電子

報、資料庫通訊刊物等多項服務，同時

會員不收費（除磁片、光碟、郵寄等工

本費外），亦有八成四的受訪者願意申

請加入成為本室資料庫會員。另外有九

成一的受訪者覺得有興趣進一步瞭解

本室資料庫的服務項目，且有高達九成

九的受訪者表示有適合的資料時，願意

向本室資料庫提出資料申請。顯示大多

數受訪者對於本室資料庫未來的發

展，皆大力支持並樂觀其成。 

四、建議 

綜合此次調查結果，歸納以下幾

點，作為資料庫未來發展與改進建議： 

1. 增加資訊公佈管道 

目前最新釋出消息主要是透過中

研院週報、調查研究工作室與中研院的

網際網路的首頁，以及於調查研究工作

室發行的調查研究期刊上發佈訊息。資

料庫於今年四月起，每四個月定期出刊

一期「學術調查研究資料庫」通訊，發

布並介紹資料庫最新釋出消息。今年八

月發行「學術調查研究資料庫」光碟，

內容包含「學術調查研究資料庫」資料

使用手冊、「學術調查研究資料庫」調

查問卷集及資料檢索功能等，寄至各大

專院校人文社會科學相關系所圖書館

以供參考。資料庫亦規劃日後定期舉辦

「調查研究方法研習班」，提供國內大

專院校師生吸取調查研究新知的機會。 

針對資訊公佈管道方面，我們已著

手規劃加強資料釋出服務的部份，加強

資料庫網站多元化功能，未來將發行電

子報，提供即時訊息，期盼藉由推廣資

料庫最新服務消息，能讓學術界更多人

受益。日後將陸續發行多項刊物（如，

技術手冊、資料彙編等）。將以多重管

道推廣介紹學術調查研究資料庫，以利

於促進國內外學術交流。 

2. 加強資料使用便利性 

在網際網路使用資料的功能及方

便性上，冀望利用網路無時間、空間限

制的特性，將更多豐富的訊息，供使用

者利用網頁查詢並取得必要資訊。目前

已提供使用者釋出資料整合查詢的服

務，以全新的網頁全文檢索服務，使查

詢使用的介面更具親和性，便利使用者

迅速獲得所需的資料。另外將已開放釋

出的調查研究計畫問卷PDF檔案，放置

資料庫網頁上供瀏覽參考。 

未來我們將陸續提供線上資料下

載功能供使用者立即獲得所需資料、次

數分配查詢服務、入口網站、線上資料

分析等功能，期盼藉由推廣並加強本室

資料庫服務，能讓學術界更多人受益。 

3. 擴展資料收藏廣度 

目前資料庫持續蒐集國科會調查

研究計畫資料，並依此份問卷調查結
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果，針對願意捐贈資料的計畫主持人進

行電話及書面信函拜訪，說明希望蒐集

的項目與資料庫處理程序，並請其提供

調查資料交予我們蒐藏與釋出，已獲得

多位計畫主持人提供寶貴資料。 

資料庫除以研究計畫問卷調查資

料為主要的蒐藏外，亦購置數據型電子

資料，除已購入行政院主計處的「人力

資源暨附帶專案調查」、美國標準普爾

公司（ Standard & Poor）發行之

COMPUSTAT資料庫、美國芝加哥大學

商學院發行之 CRSP資料庫，亦將陸續

採購，如：主計處戶口及住宅普查、家

庭收支調查等政府公務統計資料；新報

出版的上市公司產銷組合年資料、上市

公司長期投資明細資料等。另外也積極

和其他民意調查機構，如：TVBS、東

森民調中心、聯合報等單位連繫，研商

民意調查資料釋出事宜。 

未來將持續廣展資料收藏的廣度

與深度，蒐集各學科領域的資料，如：

政府公務統計資料、民意調查資料、以

各洲或各國做分類的國外統計資料、國

內調查研究資料等。 

4. 建立會員制度 

實施會員制度的目的是希望透過

此一制度，給予會員更多的權利與義

務；提供會員能在不受時間與空間的限

制下，隨時取用資料，增加資料使用的

便利性；並能享受完整與多元化的服

務，一次申請入會後即可持續使用網站

上的各項功能；促進資料庫與會員以及

會員與會員間的互動關係，將有助於學

術的交流。 

「學術調查研究資料庫」以蒐集、

整理、檢誤與保管國內以面訪、電訪、

郵寄問卷調查等方式所蒐集到的調查

資料為主要工作任務。未來將繼續擴展

收藏資料的廣度與深度，提供多元素材

予學術界再次利用；加強行政作業效

率，提供簡便、迅速、完整的服務項目

與內容，成為一流、專業且國際化的調

查資料庫。
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資料整理與檢誤經驗談 
以 SPSS程式進行邏輯檢查  

蘇婉雯 

邏輯檢誤相較於不合理值檢誤要

來的更複雜、費事，也更需要研究者的

專業知識。邏輯檢誤，主要是檢查受訪

者在通篇問卷的答案是否前後一致、是

否合理。藉由這道檢查，找到數據資料

的可疑之處，進而修改之。例如：某人

回答目前的信仰為「佛教」，但回答最

常求助的神職人員為「神父」；某人回

答年齡為「25 歲」，回答親生子女就

讀學校卻為「XX大學」；某人性別為

「男」，應跳過生育經驗不需作答，卻

回答了生育第一胎的年齡為 30 歲。像

這些狀況，都需要翻查原始問卷，查看

是否因鍵入錯誤而產生的不合理現象。 

一般而言，邏輯檢誤所發現的錯

誤答案，可能源自： 

1. 問卷設計不明確，未將跳題或續

答之相關敘述標明清楚，而導致

訪員或受訪者答題時失誤。 

2. 受訪者的失誤。如：誤解題意、

記憶模糊、精神狀態不佳、蓄意

隱瞞等。 

3. 訪員的失誤。如：弄錯限答對象、

應跳問卻沒有跳問、填錯格子、

寫錯答案等。 

4. 過錄員的失誤。如：誤填跳答碼、

填錯過錄格、寫錯過錄碼等。 

5. 輸入員的失誤。如：看錯格子或

代碼、按錯輸入鍵(通常以正確鍵

前後左右四個鍵最常誤觸) ⋯

等。 

進行「邏輯檢誤」時，覆查問卷

的工作相當費神，查核者往往需要前後

對照數道題目。如果能盡量減少這個階

段需要查驗的變項，將會是比較有效率

的作法。因此，檢誤工作比較理想的方

式是先做「不合理值檢誤」，再做「邏

輯檢誤」(「不合理值的檢誤」請

參考第二期內容)。不合理值檢誤能

夠先確立每一個變項的數據皆落在合

理範圍內；也就是說，理想上，可以去

除大半的書寫及鍵入錯誤；此時，再做

邏輯檢誤，可以比較專注於真正邏輯問

題的查驗，較有效率。 

邏輯檢誤通常需要同時考量兩題

以上的答題情形，以判斷合理的邏輯；

但為了簡化複雜的情形，最常見的做法

是兩兩考量，如果還需要第三題合併考

量，再慢慢加進來。需要邏輯檢誤的情

形包羅萬象，最重要的是，檢誤者需要

先對問卷結構與內涵、受訪者特性有深

入瞭解之後，再依照需要設計程式檢

誤。職是之故，唯有原問卷設計的研究

人員最清楚該檢誤的邏輯，二手資料蒐

集者及使用者是很難進行這部份的工

作。在此將邏輯檢核分成三類型來說

明。第一種類型是跳/續答邏輯檢核，依

據問卷的跳題設計來檢驗受訪者或是

訪員是否跳答正確；第二種類型是一般

邏輯檢核，用來檢驗受訪者在問卷題目

中前後的答案是否一致；第三種類型是

複選題的邏輯檢核，用來檢查複選題選

項之間的邏輯關係等。 

 
一、跳／續答邏輯檢核 

 
依據變項屬性的不同，我們分別
介紹「類別變項」對「類別變項」以

及「類別變項」對「連續變項」的處

理方式。 
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TABLE1.問卷題目範例一 

題號 變項名稱 變項說明 選項數值說明 

5 V5 請問您的婚姻狀況 1.未婚/同居(跳答第 8題) 

2.已婚/分居   8.拒答 

3.離婚/喪偶   9.missing 

6 V6 請問您是在哪一年結婚的？民國

___年 

0. 不適用 

98.拒答 

99.missing 

7 V7 請問您配偶是哪裡人？ 1.本省人   

2.外省人   

3.原住民   

4.其他  

8.拒答 

9.missing 

0.不適用 

 

(一)「類別變項」對「類別變項」 

交叉列聯表：將交叉列聯表中前後不合

理邏輯的域值挑出。 

步驟一：執行交叉列聯表程式 

 

【自撰語法】 

CROSSTABS TABLES= v7 BY v5.  

 

【點選選單】 

Analyze → Descriptive Statistics 

→ Crosstabs → 選擇變項(row:v5 

column:v7) 

 

TABLE 2. V5 與 V7 交叉列聯表結果 

 

 

 

 

 

 

在此例中，可以輕易地發現部分選項數

值未定義，這些數值就是不合理值，應

在邏輯檢查之前先排除掉。本例的跳／

續答邏輯中，應該挑出 V5.婚姻狀況回

答(2.已婚/分居)或(3.離婚/喪偶)者，其

V7.詢問配偶狀況時應續答而未續答

者。 

步驟二：從交叉列聯表中找出不合

邏輯的值域，配合語法找出樣本編

號 

【自撰語法】 

temporary. 

select if any(v7,0) and any(v5,2,3). 

list id v5 v7. 

執行結果，列出下面資訊： 

ID   V5  V7 

1103  2    0 
 

【點選選單】 

Data → Select Cases → If 

condition is satisfied → any(v5,2,3) 

and any(v7,0) → 設定不合格樣本 

處理方式 (filtered or deleted) 

Data → Sort Cases → 選擇上述

filter的新變項 將資料排序，檢查

DATA VIEW視窗中的資料內容 

 

FIGURE1. 點選選單篩檢條件，經排序後DATA VIEW所顯示的結果 

V7  請問您配偶是哪裡人？ * V5  請問您的婚姻狀況 Crosstabulation

Count

43 1 1 45

1 21 10 32

12 8 1 21

13 4 17

4 4

1 1

1 1

46 51 22 2 121

0  不適用

1  本省人

2  外省人

3  原住民

4  其他

5

6

V7  請
問您

配偶

是哪

裡人

？

Total

1  未婚 /同居 2  已婚 /分居 3  離婚 /喪偶 4

V5  請問您的婚姻狀況

Total
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續答與跳答是經常同時存在的兩

個相對應的邏輯，以此例為例，亦應檢

查 V5.婚姻狀況回答(1.未婚)者，其V7.

詢問配偶狀況時應跳答(0.不適用)而未

跳答者。 

在 SPSS中，需關係運算符號時，

可以使用下列三種語法： 

1. any(varname, value1, value2,...) 

2. varname = value1 , varname ~= value2, 

varname > value3, varname < value4, 

varname >= value5, varname <= value6 

3. varname eq value1 , varname ne value2 , 

varname gt value3, varname lt value4, 

varname ge value3, varname le value4 

 

第一種語法可以同時選用多個數

值，而省去每個數值撰寫而使程式長而

不容易檢查錯誤。第二種語法與第三種

語法所代表的意義是相同的。這三種語

法可以依需要與習慣混合使用。就上面

所提到的跳答邏輯，就可以有下面的兩

種寫法： 
temporary.  

select if v5=1 and any(v7,1,2,3).  

list id v5 v7. 

或 

temporary.  

select if v5=1 and v7~=0. 

list id v5 v7. 

邏輯運算符號"and"也可以寫成"＆

"，"or"也可以寫成"|"。關係運算符號與

邏輯運算符號可以完全依照個人習慣

來使用。 

另外，利用變項間數值的對應關

係，將變項排序後可以找出不相符的個

案。但是當樣本數較大或檢核連續變項

時，則不建議使用。接下去的檢查，將

介紹語法的撰寫，視窗的點選不再另外

說明。 

(二)「類別變項」對「連續變項」 

當樣本數較大或連續變項數值

分佈較廣時，為避免執行 crosstab的

結果表格太大，建議直接以語法設定

邏輯運算關係以進行檢核。因此，以

下範例省略交叉列聯表結果。「連續

變項」對「連續變項」亦建議以下列

語法直接進行檢核。 

 

【自撰語法】 

crosstab v6 by v5. (交叉列表結果略) 

temporary.  

select if v5=1 and v6~=0. 

list id v5 v6. 

 

temporary.  

select if any(v5,2,3) and v6=0. 

list id v5 v6. 

 

執行結果，列出下面資訊： 

未被 filter的資
料，即為不合

邏輯條件者。 
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ID   V5   V6 

1147  1   67 

 

ID   V5   V6 

1114  2    0 

二、一般邏輯檢核 

一般變項邏輯的檢核，意指檢查受

訪者對問卷中具相關性的問題，是否有

一致的回答。例如詢問家中是否有電

腦，以及在什麼地點使用網際網路，若

受訪者先回答家中沒有電腦，不應再回

答主要使用網際網路的地點在家裡。一

般變項間的邏輯是較難檢驗的，通常需

要瞭解整份問卷的設計以及填答方

式，才能夠掌握所有變項間的邏輯關

係。一般邏輯檢核的方式與跳答邏輯檢

核的方式大致上相同。下列介紹以交叉

列聯表檢核「類別變項」對「類別變

項」；及利用新建變項檢核「連續變項」

對「連續變項」兩種。 

 

(一)「類別變項」對「類別變項」 

TABLE 3. 問卷題目範例二 
題號 變項名稱 變項說明 選項數值說明 

9 V9 請問您家中是否有電腦設

備？      
1.是  
2.否 
 

8.拒答 
9.missing 

10 V10 請問您大部分都是在什麼

地點使用網際網路？ 
1.家中   
2.公司   
3.親朋好友或同學家  
4.網咖   
 

5.不會/沒有在上網  
6.其他 
8.拒答 
9.missing 

  

【自撰語法】 

crosstabs tables v10 by v9. 
 

TABLE 4. V9與V10交叉列聯表結果 

 
 
 
 
 
 
 
 
 
 

在此例中，V9.答家中無電腦者，v10中

不應出現在家裡上網，因此需列出這些

不合邏輯者受訪者，進一步查詢內容。 

【自撰語法】 

temporary. 

select if any(v9,2) and any(v10,1). 
list id v9 v10. 

 
列出結果如下： 

ID   V9  V10 

1147  2    1 

1183  2    1 

1156  2    1  

1182  2    1 

1133  2    1 

1134  2    1 

1149  2    1 

1105  2    1 

1191  2    1 

1203  2    1 

1218  2    1 

(二)「連續變項」對「連續變項」 

對兩連續變項進行數學運算產生新

V10  請問您大部分都是在什麼地點使用網際網路？ *
V9  請問您家中是否有電腦設備？ Crosstabulation

Count

8 11 19

16 19 35

11 4 15

9 15 24

11 9 20

4 3 7

1 1

60 61 121

1  家中

2  公司

3  親朋好友或同學家

4  網咖

5   不會 /沒有在上網

6   其他

8  拒答

V10  
請問

您大

部分

都是

在什

麼地

點使

用網

際網

路？

Total

1  是 2  否

V9  請問您家中

是否有電腦設

備？

Total
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變項，再界定新變項的範圍，藉以挑 出不合理值及樣本編號。 

TABLE 5. 問卷題目範例三 
題號 變項名稱 變項說明 選項數值說明 

2 V2 請問您是在哪一年出生的？民國____
年 

98.拒答 

99.missing 

.(略). .(略). (略) (略) 

6 V6 請問您是在哪一年結婚?民國____年 0.不適用 

98.拒答 

99.missing 

【自撰語法】 

compute v6_2=v6-v2. 

temporary.  

select if v6_2<=15 and v6~=0. 

list id v2 v6 v6_2. 

列出結果如下： 
ID    V2   V6     V6_2 

1182  68    83       15 

1184  69    84       15 

1122  75    90       15 

1214  75    90       15 

1169  68    80       12 

1128  54    32      -22 

【點選選單】新建變項 

Transform → Compute → 定義

Target Variables → 設定變數邏輯關

係(v6_2=v6-v2) 

 

Data → Select Cases → If condition 

is satisfied → 設定 v6_2<=15→ 

設定不合格樣本處理方式 

(filtered or deleted) 

Data → Sort Cases → 選擇上述

filter的新變項 將資料排序，檢

查 DATA VIEW視窗中的資料內

容 

三、複選題組的檢查 

複選題組的檢查是進階級的資料

整理工作，運用上面提過的方式，在比

較複雜的邏輯中使用。常見的複選題邏

輯可以簡單的分為兩類：一種是複選題

題組的不合理值檢查，另一種是複選題

組的邏輯檢查。接下來就直接舉例介

紹。 

TABLE.6 問卷題目範例四 
題號 變項名稱 變項說明 選項數值說明 

一 A1 請問您是否聽說過中央研究院調查研究工

作室「學術調查研究資料庫」？ 
(1) 是(續答第二題) 

(2) 否(跳答第二十題) 

(9) missing 

二、請問您最初是從何處得知本室資料庫？(可複選) 

(1) A2.1 中央研究院週報 

(2) A2.2 網際網路(WWW) 

(3) A2.3 本室出版品(「調查研究」等) 

(4) A2.4 學術論文會議上 

(5) A2.5 學校課堂上 

(6) A2.6 同學或朋友 

(7) A2.7 執行國科會研究計畫 

(8) A2.8 其他(請說明) 

(1) 是    

(2) 否 

(8) 跳答  

(9) missing 
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《過錄說明》 

本題組中，第一題中回答"1.是"者，需續答第二題；回答"2.否"者，第二題全

數為"8.跳答"；未回答者，過錄為"9.missing"，第二題亦全為"9.missing"。" 

需回答第二題者(第一題回答"1.是"者)，有勾選之題目過錄為"1.是"，未勾選

過錄為"2.否"，至少應勾選一小題。未勾選(1)-(7)題者，應勾選第(8)題。但(1)-(7)
題有勾選者，仍可勾選第(8)題。全數未填答者，則應過錄為"9.missing" 

 

(一) 複選題題組的不合理值檢查 

在資料整理時應先就第二題(1)-(8)

小題的資料進行不合理值檢查。光就第

二題，可以整理出下列三條邏輯： 

1. 至少要有一題回答 1，不可全為 2。

(題目設計(8)與(1)-(7)互斥) 

2. 需跳答者，應全數跳答；資料遺漏

者，應全數遺漏。 

3. 選項(1,2)與選項(8,9)應為互斥。(跳

／續答邏輯) 

在此特別說明，若將數值設為系統

遺失值(system missing)，SPSS邏輯語法

篩選資料時，將略過系統遺失值的運算

以及與其他數值的比對，因此篩選時宜

取消系統遺失值的設定。以下說明如何

挑出第二題的八小題全數回答 "2.否" 

(選項 8.與選項 1.-7.有互斥的設計)者，

利用在上面介紹過的邏輯語法，將變項

與條件一個個串接起來。 
 

【自撰語法】 
/*挑出第二題的八小題全數回答 "2.否" */ 

TEMP. 

SELECT IF A2.1=2 and A2.2=2 and A2.3=2 and 
A2.4=2 and A2.5=2 and A2.6=2 and A2.7=2 and 
A2.8=2. 

LIST ID A2.1 TO A2.8 . 
 

列出結果 
ID A2.1 A2.2  A2.3 A2.4 A2.5 A2.6 A2.7 A2.8 

495  2   2    2    2    2   2   2    2 

題目數與邏輯條件越多，逐一撰寫語法

隨之多而且容易遺漏。在這裡利用新建

變項的方式，將複選題組轉換成單純的

幾個變項，在其後的檢查都可以利用。 

【自撰語法】 

/*依據邏輯第 1,2條，過錄題組依據其邏輯轉
成單一變項 a2，未符合邏輯者，a2=0*/ 

COMPUTE A2=0. 

IF 
(A2.1=1|A2.2=1|A2.3=1|A2.4=1|A2.5=1|A2.6=1|
A2.7=1|a2.8=1) A2=1. 

IF (A2.1=8 & A2.2=8 & A2.3=8 & A2.4=8 & 
A2.5=8 & A2.6=8 & A2.7=8 & A2.8=8) A2=8. 

IF (A2.1=9 & A2.2=9 & A2.3=9 & A2.4=9 & 
A2.5=9 & A2.6=9 & A2.7=9) A2=9. 

 

/*依據邏輯第 3條，挑出在八題中任一位置出
現 8與 9的數值，轉成單一變項A2a=88 與 99*/ 

COMPUTE A2a=0. 

IF (A2.1=8 | A2.2=8 | A2.3=8 | A2.4=8 | A2.5=8 | 
A2.6=8 | A2.7=8 | A2.8=8) A2a=88. 

IF (A2.1=9 | A2.2=9 | A2.3=9 | A2.4=9 | A2.5=9 | 
A2.6=9 | A2.7=9) A2a=99. 

 

/*挑出不符合邏輯第 1,2條的資料*/ 

temp. 
select if a2=0. 
list id a2 a2.1 to a2.8. 
(結果一) 

/*挑出不符合邏輯第 3條的資料*/ 

temp. 
select if a2=1 and (a2a=88 |a2a=99). 
list id a2 a2a a2.1 to a2.8. 
(結果二) 

 

結果一：不只列出全為 2的資料，也
列出其他邏輯錯誤的情形 
LINE   1: ID A2 A2.1 A2.2 A2.3 A2.4 A2.5 

LINE   2: A2.6 A2.7 A2.8 

  ID:  379  .00   8   2  2  2  2 

A2.6:    2    2   2 

  ID:  495  .00   2   2  2  2  2 

A2.6:    2    2   2 

  ID:  875  .00   8   8  8  8  8 

A2.6:    8    8   9 
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結果二：列出 1 與(8,9)同時存在的資料  
LINE   1: ID A2 A2A A2.1 A2.2 A2.3 A2.4 

LINE   2: A2.5 A2.6 A2.7 A2.8 

ID:  9998   1.00   88.00   8   1   2  2 

A2.5:     2     1      2    2 

  ID:  2829   1.00   99.00   2   9   2  2 

A2.5:     2     2      1    2 

SPSS 的報表中變項數超過一行

時，將在報表前以 line 1, line 2等標明

每一行中變項出現的次序。由上面這兩

種撰寫方式的結果比較起來，利用新建

變項再撰寫邏輯語法，可以同時檢查好

幾個邏輯問題，不需逐一撰寫。這樣的

檢查工作，才能確切檢查複選題組中是

否包含不合理值，應在進行下一個跳／

續答的複選題組檢查前先進行。 

(二)跳／續答的複選題組的檢查 

以挑出第一題回答 "1.是"者，第二

題的八小題中，不該出現"8.跳答"(跳／

續答之後的複選題組)；第一題回答 "2.

否"者，第二題的八小題中，應全數為 "8.

跳答"，而不該出現"1、2、9"為例子；

第一題為遺漏者，第二題的八小題中，

應全數為 "9.跳答"，而不該出現"1、2、

8"為例子。 

【自撰語法】 
temp. 
select if a1=1 and a2~=8. 
list id a1 a2 a2.1 to a2.8. 
(結果一) 

temp. 
select if a1=2 and a2~=8. 
list id a1 a2 a2.1 to a2.8. 
(結果二) 

temp. 
select if a1=9 and a2~=9. 
list id a1 a2 a2.1 to a2.8. 
(結果三) 

結果一：列出第一題選 1 而第二題不
該跳答卻跳答者，以及在前一步驟就

應挑出的不合理值。 
 
 

LINE   1: ID A1 A2 A2.1 A2.2 A2.3 A2.4 
LINE   2: A2.5 A2.6 A2.7 A2.8 

  ID:  2465   1 8.00    8    8    8    8 

A2.5:     8   8    8    8 

  ID:   379   1  .00    8    2    2    2 

A2.5:     2   2    2    2 

  ID:   495   1  .00    2    2    2    2 

A2.5:     2   2    2    2 

結果二：列出第一題選 2 而第二題該
跳答卻未跳答者，以及在前一步驟就

應挑出的不合理值。 
LINE   1: ID A1 A2 A2.1 A2.2 A2.3 A2.4 
LINE   2: A2.5 A2.6 A2.7 A2.8 

  ID:  2583  2  1.00  1   2   1   2 

A2.5:     2  2     2  2 

  ID:   875  2   .00  8   8   8   8 

A2.5:     8  8     8  9 

結果三：列出第一題為遺漏值，而第
二題亦應為遺漏但卻出現其他答案

者。 
LINE   1: ID A1 A2 A2.1 A2.2 A2.3 A2.4 
LINE   2: A2.5 A2.6 A2.7 A2.8 

  ID:  1229   9  8.00    8   8   8   8 

A2.5:     8   8     8    8 

  ID:  2350   9  1.00    2   2   2   2 

A2.5:     2   1     2    2 

 

上述的邏輯錯誤，在不合理值檢

查時不容易被發現。因此需要進一步

的複選題邏輯檢查。邏輯檢核是一個

相當重要且辛苦的工作，卻常被研究

者所忽視。邏輯的繁複程度，會依題

目的設計而有所不同，需要心思縝密

的進行。邏輯語法的撰寫，往往因人

而異而多采多姿。在辛苦之中，能撰

寫各種程式處理各式狀況，及時修正

資料內容，確保資料品質，也是相當

具有成就感的一份工作。本室連續兩

期撰寫資料整理工作的經驗與學術

界分享，希望藉此拋磚引玉，進而提

升國內調查資料的品質。(完) 
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主計處人力資源調查 
資料背景簡介 

系列一 林璟鈺

  

   行政院主計處按月辦理的「人力資

源調查」，係以家庭為對象，蒐集民間

十五歲以上人口之品質、數量、勞動力

結構、就業、失業、失業原因、非勞動

力構成等有關基本資料，是一全國性的

抽樣調查資料，為現代國家配合經濟、

社會發展不可或缺之重要調查資料。茲

將資料背景簡介如后： 

一、沿革 

    我國人力資源統計，創始於民國51

年 4月，由臺灣省政府社會處成立勞動

力調查統計研究發展小組，進行勞動力

調查制度之研訂。於 52年 10月正式推

動「勞動力調查」工作，每年按季舉辦

四次。迨民國 66 年由主計處「勞工統

計調查評審委員會」接辦臺灣地區勞動

力調查業務，翌年 1月開始正式辦理調

查。於民國 72 年 7 月正式納入組織，

隸屬主計處第四局主辦。 

二、調查範圍及對象 

本調查之地區範圍為臺灣地區（不

含金門及馬祖地區），包括臺灣省、臺

北市及高雄市，而以現住此一地區內之

普通住戶與共同事業戶戶內年滿十五

歲，自由從事經濟活動之民間人口為對

象，但不包括武裝勞動力及監管人口。 

三、調查方法及時間 

調查兼採派員面訪與電話訪問方

式，由臺北市、高雄市暨臺灣省各縣市

政府主計處（室）遴選調查員擔任。調

查時期定為每月辦理一次，以各月含十

五日之一週為資料標準週，而於次週查

填標準週內發生之事件，並以標準週最

後一日午夜十二時正為分界，校正各種

人口異動情形；在此時以前死亡或遷出

者不予調查，而以後死亡或遷出者，仍

予調查。 

四、抽樣方式 

（一）抽樣設計 

抽樣母體：以「台灣地區年終戶籍

村里別統計資料檔」為抽樣母體。 

本調查採用「分層二段隨機抽樣

法」，第一段抽樣單位定為村里，而第

二段抽樣單位定為戶。 

進行第一段抽村里時，以臺灣地區

廿三個縣市（含台北市、高雄市）各為

單一副母體，而各副母體分別依各村里

都市化程度、產業結構及教育程度為分

層標準，釐定適當層數。 

第二段抽樣由第一段中選樣本村

里之最新戶籍資料名冊抽出戶。 
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（二）樣本大小及抽出率 

本調查估計抽出第一段樣本約為

520 個村里；第二段樣本戶約 20,000

戶，總抽出率約為 3.1 ‰，包括年滿十

五歲人口約六萬人。依照台灣地區的總

抽 出 樣 本 按 紐 曼 配 置 （ Neyman 

allocation）分配給廿三縣市。 

（三）樣本抽取 

由主計處統籌辦理，第一段抽樣先

將全部村里按既定準則劃分成層，再將

各層村里按戶數之大小排列，然後隨機

抽出樣本起號，即以預定抽出間隔用系

統法抽出樣本村里。第二段抽樣以最新

戶籍資料為母體底冊用系統法抽出樣

本戶。 

1.   第一段樣本村里之決定 

根據各層之綜合指標值（各種特徵

值之變異數函數）大小，將所需調

查之戶依紐曼配置分配給各層。計

算各層村里之平均戶數，決定調查

之應抽村里數，將各層村里按行政

順序（村里代號）排列，然後隨機

抽出樣本起號，即以預定抽出間隔

用系統法抽出樣本村里。 

2.   第二段樣本村里之決定 

根據上述方法抽出之樣本村里，按

照各村里的母體戶數決定抽出戶

數，再將村里內所有住戶地址之路

名、段名、鄰號以及樓室排序，然

後隨機抽出樣本起號，即以預定抽

出間隔用系統法抽出樣本戶。 

（四）樣本輪換方式 

樣本係採輪換方式，每一樣本戶須

連續查填兩個月，隔年同期再查填兩

次，共查填四次。即各層之第一段單位

（村里）先分成 A、B、C、D四組，各

組再區分為兩小組；共得八小組，即

A1、B1、C1、D1、A2、B2、C2、D2；

每小組抽出三組樣本村里，每組樣本村

里輪換調查四個月；故一年中各組內村

里輪換調查三次，其輪值村里之開始調

查期間為 A組一、五、九月；B組二、

六、十月；C組三、七、十一月；D組

四、八、十二月，由抽出之第一段樣本

單位內再抽出兩組調查戶，組成第二段

樣本，每組調查戶連續接受調查兩個月

後輪換。續 A1、B1、C1、D1 組樣本

使用一年後，繼續使用一年而變成A2、

B2、C2、D2，至於 A2、B2、C2、D2

組樣本使用一年，即不再續用，而更換

樣本為 A1、B1、C1、D1組，以後即按

此一方式循環使用。 

（五）共同事業戶之處理 

共同事業戶之抽出，用上年各村里

共同事業戶人口數為抽樣母體，以人為

單位，直接抽出予以調查。 

（六）本調查之樣本大部分採用既定之

抽樣方法取得，但有關水電燃氣

業部分則由該業各公司提供有關



主計處人力資源調查資料背景簡介 

44 

寄送

名冊 

調查表回

收、複審 

資料，逕送主計處應用。 

五、調查資料之估計方法 

調查所得各項資料用比率估計法

估計，並分別按二十三個縣市性別及年

齡組別之戶籍人口予以修正，再將二十

三個縣市之修正估計值加計，即得臺灣

地區之估計值，並鑑定變異原因。 

六、作業流程 

 

 

每年 每半年 每月下旬：各 次月初：主 
一次 一次   縣市電話控制 計處不定期      

制複查  控制複查 

七、資料變革 

根據主計處提供自 67年 1 月至 90

年 5月之相關資料，本室資料庫整理資

料內容後發現，歷年問卷調查題目內容

大致相同，唯在選項數值方面有部分變

動，概述如后： 

（一）地區：67年及 68 年分為台灣省

及台北市；69 年以後分為台灣

省、台北市及高雄市。 

（二） 層別：67年及 68年分為廿五層；

69年至 81 年分為廿四層；82年

以後分為七層。 

（三）村里編號：主計處提供村里編號

電子檔共分為 78年以前版本（共

六碼）、79年版本（共七碼）、80

年以後版本（共七碼）及 90年版

本（共七碼），共計四種版本。67

年至 71 年資料因原為書面資

料，經重新建置電腦檔案，後三

碼的村里代號與 78 年版本有多

筆無法配合，因此資料庫在釋出

過錄編碼簿及程式時，僅以前三

碼的鄉鎮市區代號製作選項數值

資料。 

（四）與戶長之關係：67 年至 77 年為

八個選項；78年以後增為十四個

選項。 

（五）教育程度：67年至 76年 5 月為

八個選項；76 年 6 月至 83 年增

為九個選項；84年以後增為十個

選項。 

（六）上週工作幾小時：84年以後刪除

合計工作時數問項。 

（七）行業及職業：67 年至 73 年 6月

為中華民國行職業分類標準 64

年版；73 年 7 月至 76 年為中華

民國行職業分類標準 72年版；77

年至 81 年為中華民國行職業分

類標準 76年版；82年至 85年為

中華民國行職業分類標準 80 年

抽

樣

縣市實地

調查、初審

電腦、人

工驗誤 
母體

推估 

統計

分析 
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版；86 年至 90 年 5 月為中華民

國行職業分類標準 85年版。 

（八）工作場所： 

1. 86 年以後新增工作場所地點

資料。 

2. 67 年無從業員工人數問項；

68年至83年新增從業員工人

數問項，共八個選項；84 年

以後從業員工人數為九個選

項。 

  主計處按月公布的勞動力、就業

者、失業者、非勞動力、失業率、勞動

力參與率等指標，是依據人力資源調查

的結果進行統計，此筆資料在國內勞動

相關調查中，具有樣本數龐大等優勢，

已廣被國內學術界使用。 

另外，為應各機關人力資源運用與

經社決策施政需要，獲取較為詳細資

料，乃利用同一樣本附帶舉辦下列十四

種專案調查，涉及社會各個層面問題，

俾更深入瞭解勞動力與國民生活之重

要特性。我們將於下期繼續介紹。 

資料來源： 

行政院主計處普查局，網址：

http://www.dgbasey.gov.tw/census~n/wel

come.htm
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淺談信度 

王文心 

一、何謂信度？ 

信度（reliability）是指對同一現象

重複測量時，所得到結果一致性的高低

程度。中文所稱的可靠性，以及英文的

Reproducibility、Repeatability等，都是

信度的同義複詞。影響信度的原因包括

不 同 人 、 工 具 造 成 的 影 響

（Interobserver），以及同一人、工具，

但不同時間或環境造成的影響

（Intraobserver）。 

二、信度與效度的關係 

除了信度之外，效度（validity）也

是我們常用來檢驗測量品質以及測量

結果使用的指標。效度是指一項工具在

測量其所欲測的特質或行為時所具有

的真確性，又可分為內在效度（internal 

validity）—結果之正確性，與外在效度

（external validity） —結果向外推論之

廣度。信度與效度之間沒有絕對的相

關，信度好效度有可能不好，反之，效

度好，信度也不一定好。在這裡，我們

用一張圖來表示信度和效度之間的關

係（圖 1）。圖中的黑點代表測量的結

果，若是重覆測量的結果一致性較高

時，黑點就會較為集中（信度好），若

一致性不高時，黑點則較分散（信度不

好）；而圖中最中間的圓圈代表真正的

值，若黑點落在最中心的圓圈裏，才代

表測量到了真正的值，所以有可能測量

結果的一致性高，但確測不到真正的結

果（圖 1左下）。 

圖 1：信度與效度意示圖 

 

 

 

 

 

 

 

資料來源：王榮德，流行病學方法論 

三、常用的信度指標 

簡單介紹信度與效度的概念之

後，我們將進入今天的主題---我們常在

論文中見到作者使用的信度指標有哪

些？以及這些指標是如何計算的。本文

將包括測量內部一致性的 Cronbach’s á

值；為檢驗某一種工具在重覆施測或兩

種工具同時施測時，其分類結果是否一

致的 Kappa值；以及同一工具在兩個不

同時間重覆測量所使用的再測信度

ICCR。我們將這三種指標的重要特性整

理成表一，後文中將個別詳細介紹，並

以實際的例子來介紹如何使用 SAS、

SPSS等統計軟體進行計算這些指標。 
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表一  常用的信度指標 

指標 使用時機 資料特性 

Cronbach’s á 檢驗同一測量工具的內部一

致性  

只須施測一次 

Kappa  檢驗某一種工具在重覆施測

時的一致性，或兩種測量工具

在分類結果上的一致性 

使用兩次測量的分類結果進行估算 

ICCR  檢驗同一測量工具在兩個不

同時間重覆施測時其分數的

穩定性 

用於基本上呈穩定趨勢的特質，如

智力、性向，需要測量兩次，並且

使用分數進行估算。 

（一）Cronbach’s á 

Cronbach’s á主要是為檢驗測量工

具內部的同質性、穩定度或一致性而

設，所以不用重覆測量兩次。最早在測

量內部一致性時，是使用庫李

（Kuder-Richardson）信度，但是庫李

信度（公式 1）只適用於測量結果以二

分法計分之測量，例如：考試結果正確

答案得分為 1，非正確答案為 0之情況。 







−

−
= ∑

21
1

20
SD

pq

k
k

KR  （公式 1） 

 k：試題總數 

 SD2：為整個測驗的變異數 

 p：樣本中答對該題答案之人數的百分

比，代表試題的難度。 

 q：樣本中答錯該題的人數百分比  

∑ pq：每一題試題答對與答錯人數百

分比乘積的總合。 

資料來源：葛樹人，心理測驗學 

而為因應在測量心理或人格特質時

所使用的多重評分標準需要，Cronbach

（1951）將庫李信度公式加以修改，以

∑ 2)(SDi 取代∑ pq而設計出下列公式

（公式 2）。KR 20可視為 Cronbach’s á

的一個特例，即當試題答案以二分法計

分時，∑ 2)(SDi 即為∑ pq。 

Cronbach’s á  

=











−

−
∑

2

2)(
1

1 SD

SDi

k

k   （公式 2） 

(SDi)2：團體中所有受測者在單一試題

上的變異數 

SAS 和 SPSS 都可以直接計算

Cronbach’s á值，程式語法和視窗點選

方式說明如后。 

假設某一份五點量表有五個題目

（Q1-Q5），1 分代表非常不同意，5分

代表非常同意，分別讓 19 位受試者從

1~5 分中選取其認為最符合自己狀況的
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分數，最後得到的資料如下（在此列出

部份資料）： 

範例一     

Id    q1 q2 q3 q4 q5

001    2 3 4 2 3

002    3 2 5 3 3

003    1 4 4 2 2

004    2 3 3 1 4

005    3 3 2 2 3

006    4 4 3 3 5

1.SAS語法 

PROC CORR ALPHA; 

  VAR Q1-Q5; 

  RUN; 

執行上述程式得到的結果共有四

部份：(1)這五個變項的基本統計量；(2) 

Cronbach’s á值；(3)刪除某一題目後的

Cronbach’s á 值；以及 (4)皮爾森

（Pearson）相關係數（在此不列出）。

(1)基本統計量 

                                       Simple Statistics 

   Variable       N        Mean       Std Dev       Sum       Minimum      Maximum 

   Q1           19       2.78947      1.18223      53.00000      1.00000      5.00000 

   Q2           19       2.89474      1.10024      55.00000      1.00000      5.00000 

   Q3           19       2.78947      1.22832      53.00000      1.00000      5.00000 

   Q4           19       2.42105      1.12130      46.00000      1.00000      5.00000 

   Q5           19       3.21053      1.03166      61.00000      2.00000      5.00000 

(2) Cronbach’s á值 

                        Cronbach Coefficient Alpha 

 
                       Variables            Alpha 
                      ----------------------------------------------- 
                       Raw    0.416414 

                       Standardized         0.417087 

(3)刪除某一問題後的Cronbach’s á值 

 

                        Cronbach Coefficient Alpha with Deleted Variable 

                                Raw Variables              Standardized Variables 

            Deleted      Correlation                     Correlation 

            Variable      with Total           Alpha      with Total           Alpha 

            ------------------------------------------------------------------------------------------------------------ 

            Q1              0.411550        0.193122        0.421926        0.193376 

            Q2              0.278383        0.314530        0.283754        0.309385 
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            Q3              0.004178        0.523535        -.005105        0.516574 

            Q4              0.387659        0.224100        0.379462        0.230268 

            Q5              0.045195        0.472242        0.048854        0.481272 

2.SPSS語法： 

RELIABILITY 

  /VARIABLES=q1 q2 q3 q4 q5 

  /FORMAT=NOLABELS 

  /SCALE(ALPHA)=ALL/MODEL=ALPHA 

  /SUMMARY=TOTAL MEANS VARIANCE COV CORR . 

3.SPSS視窗點選方式： 

從功能選單的「Analyze」進入，選「Scale」，再選擇「Reliability analysis」後，

便出現下面的畫面。 

 

 

 

 

 

 

 

 

 

 

 

將同一量表的變項選到右邊，並進入「Option」設定後，執行結果依序為(1)

基本統計量；(2)刪除某一變項（題目）後的 Cronbach’s á 值；以及(3)Cronbach’s á

值。得到的結果跟使用 SAS統計軟體是一樣的。 
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(1)基本統計量 

R E L I A B I L I T Y  A N A L Y S I S  -  S C A L E   (A L P H A) 

Item Means  Mean    Minimum   Maximum    Range Max/Min Variance 

2.8211    2.4211   3.2105    .7895 1.3261  .0798 

Item Variances Mean    Minimum   Maximum     Range   Max/Min Variance 

1.2877    1.0643   1.5088    .4444 1.4176  .0294 

Inter-item 

Covariances  Mean    Minimum    Maximum    Range Max/Min Variance 

.1608    -.2865   . 4912    .7778 -1.7143 .0568 

Inter-item 

Correlations  Mean    Minimum    Maximum    Range Max/Min Variance 

.1252    -.2261    .3982    .6243  -1.7609  .0355 

 

(2)刪除某一問題後的Cronbach’s á值 

Item-total Statistics 

               Scale        Scale      Corrected 
               Mean       Variance      Item-         Squared        Alpha 
              if Item        if Item       Total         Multiple        if Item 
              Deleted       Deleted    Correlation     Correlation       Deleted 
 
Q1            11.3158       5.8947        .4115         .2080         .1931 
Q2            11.2105       6.8421        .2784         .1957         .3145 
Q3            11.3158       8.1170        .0042         .1162         .5235 
Q4            11.6842       6.2281        .3877         .2385         .2241 
Q5            10.8947       8.3216        .0452         .1679         .4722 

 

(3)Cronbach’s á值 

Reliability Coefficients     5 items 

Alpha =   .4164           Standardized item alpha =   .4171 

Cronbach’s á的最低接受標準值，Merchant(1985)認為是最低可接受的限度為

0.5-0.6之間。 
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（二）Kappa值 

Kappa值測量的也是一致性，但與

Cronbach’s á不同點在於 Kappa需要測

量兩次，比較的是兩種不同工具在重覆

測量，或同一種工具不同時間測量分類

結果的一致性。估計Kappa值之前，應

事先定義測量結果分類的標準，例如：

如何將測量分為「及格」與「不及格」、

「陽性」或「陰性」等類別。 

簡易估計 Kappa 值的方法如公式

3-1 到公式 3-3。PA代表”同意百分比”

（percent agreement），用來計算兩測量

工具（或同一工具重覆測量）在結果上

完全一致的百分比。同意百分比愈高，

測量之信度便愈高。 

                                                     

             （同意百分比）（公式 3-1） 

                                        

（公式 3-2） 

         

            （公式 3-3） 

 

在此舉例說明，假設我們用兩種

方法來測量某社區居民對登革熱病毒

的保護力（範例二），陽性（+）代表有

保護力，陰性（-）代表沒有保護力，兩

種測量的結果如下所示；兩種方法測量

結果皆為陽性的有 10 位，皆為陰性的

有 50 位，A方法為陽型 B方法為陰性

的有 10 位，A方法陰性 B方法陽性的

有 30 位。依上述公式，便可得到這兩

種工具測量結果的一致性為 0.091，一

致性並不理想。 

範例二 

              

             

             

 

 

  

 1 2 … k  

1 N11 N12 … N1k N1. 

2 N21 N22 … N2k N2. 
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我們再來看一個複雜一點的例

子，當測量的分類結果不只一類時，同

樣也是按照上述的公式，將數值代入計

算即可。在範例三中，A君在檢查血液

中血紅素時，對同一檢體進行兩次的測

量，以瞭解其操作的穩定性，結果如下

表所示。第一次和第二次血紅素測量結

果都是 9的有 5個檢體，第一次測量為

10、第二次測量得到 9的有 1個檢體，

依此類推。最後計算得出 Kappa 值為

0.33，表示同一檢體測量結果的一致性

並不佳，A君可能需要對其操作過程加

以檢討，以提高測量的一致性。 

範例三： 

                                      

 

                                     

 

     

 

 

 

Kappa 值也可以直接用 SAS 或

SPSS 求得，但須注意原始資料的格式

須為「0」與「1」。為了讓讀者瞭解資

料格式，我們使用範例二的原始資料進

行說明，先介紹 SPSS 視窗點選的方

式，再分別示範如何撰寫 SPSS及 SAS

的語法。 

 

1.SPSS視窗點選 

資料格式如下圖的最左方，obs1

和 obs2分別是A方法和 B方法，資料

格中 0 代表陰性，1 代表陽性。計算時

先從功能選單的「Analyze」進入，選

「 Descriptive Statistics 」後再選擇

「Crosstabs」，便會跳出「Crosstab」的

對話視窗（如下圖）。 

 

 

 第二次測量的血紅素數值  

  9 10 11 12 13 14 15  

9 5 2      7 

10 1 8 3 4    16 

11  1 6 15 3   25 

12 2 1 2 15 5   25 

13    9 10 4  23 

14    4 2 7 3 16 

第
一
次
測
量
的
血
紅
素
數
值

 

15     1 8 4 13 
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最後後點選「Statistics..」，勾選「Kappa」及其他相關統計值，如「McNemar」

等。執行結果如下（只擇取部份），三個表依序分別是與例 1 相同的交叉列聯表、

含McNemar Test結果的卡方檢驗結果、以及 Kappa值。 

OBS2 * OBS1 Crosstabulation

Count

50 10 60
30 10 40
80 20 100

0
1

OBS2

Total

0 1
OBS1

Total
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Chi-Square Tests

1.042b 1 .307
.586 1 .444
1.026 1 .311

.320 .221

1.031 1 .310
.002c

100

Pearson Chi-Square
Continuity Correctiona

Likelihood Ratio
Fisher's Exact Test

Linear-by-Linear Association
McNemar Test
N of Valid Cases

Value df
Asymp. Sig.
(2-sided)

Exact Sig.
(2-sided)

Exact Sig.
(1-sided)

Computed only for a 2x2 tablea. 

0 cells (.0%) have expected count less than 5. The minimum expected count is 8.00.b. 

Binomial distribution used.c. 

 

Symmetric Measures

.102 .102 1.016 .312c

.102 .102 1.016 .312c

.091 .091 1.021 .307
100

Pearson's RInterval by Interval
Spearman CorrelationOrdinal by Ordinal
KappaMeasure of Agreement

N of Valid Cases

Value
Asymp.
Std. Errora Approx. Tb Approx. Sig.

Not assuming the null hypothesis.a. 

Using the asymptotic standard error assuming the null hypothesis.b. 

Based on normal approximation.c. 
 

 

2.SPSS語法 

CROSSTABS 
  /TABLES=obs2  BY obs1 
  /FORMAT= AVALUE TABLES 

  /STATISTIC=CHISQ CORR KAPPA 
MCNEMAR 
  /CELLS= COUNT . 

 

3.SAS語法 

DATA A; 
INFILE 'D:\KAPPA.TXT'; 
INPUT OBS1 OBS2; 
 
PROC FREQ; 
     TABLE OBS2*OBS1/AGREE; 
RUN; 

執行後可以得到與 SPSS一樣的結果： 

 

                  

The FREQ Procedure  

Table of OBS2 by OBS1 
OBS2      OBS1 

 

Frequency 

0       1    Total 

--------------------------------------------------- 

0     50      10      60 
--------------------------------------------------- 

1     30      10      40 

---------------------------------------------------- 

Total        80       20     100 
 
 
      Statistics for Table of OBS2 by OBS1 
 
                McNemar's Test 
          ------------------------------------ 
           Statistic (S)    10.0000 
           DF                     1 
           Pr > S            0.0016 
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Simple Kappa Coefficient 
-------------------------------------------------------- 
Kappa     0.0909 
ASE     0.0911 
95% Lower Conf Limit  -0.0876 
95% Upper Conf Limit   0.2695 
 
             Sample Size = 100 

當 Kappa值等於 1時，代表完全一

致，K>0.80表一致性佳，而 K<0.4 時，

則代表一致性不好。 

4. McNemar’s test 

在上面的計算中，讀者可以看到

McNemar檢定的結果，其檢定的結果與

Kappa 值代表的意義是一樣的。

McNemar 氏考驗又稱為非獨立樣本比

率數的卡方考驗，或稱為相依樣本的卡

方檢定，可用來檢驗重複量數之資料，

例如：看不同測量工具對同一樣本測量

的結果是否一致，或是看同一樣本，前

後兩次反應之異同。 

      Observer2           

 

 

 

 

 

 （公式 4） 

我們以先前舉過的範例二來做說

明，McNemar 檢定的虛無假設（Null 

hypothesis）是假設兩種方法測量到的結

果不會有差異，但是當我們計算結果發

現 p值小於 0.05時，便推翻虛無假設，

亦即不同的測量方法所得到的測量結果

是不一樣的，與我們之前使用 Kappa值

得到的結論 —兩種方法一致性不佳是一

樣的。同樣的，也與上面以統計軟體得

到的計算結果是一樣的。 

範例： 

H0:不同測量方法不會對測量結果造成差異。 

HA:不同測量方法對測量結果造成差異。 

  

 

 

 

代入公式 4計算：          

 p=0.002 

（三）ICCR--再測信度（test-retest 

reliability） 

一些人類特質，例如：智力、性向、

人格等基本上是穩定的，故在測量這類

心理特質時，測驗分數具有高度穩定性

是必要的。最適宜的相隔時間隨測驗目

的和性質而異，少者兩週、多則六個月

到 1、2年。 

雖然 Kappa 值也可用來當然再測

信度的指標，但是 Kappa處理的是分類

過後的測量結果，像是智力、性向、人
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格等就不適合用 Kappa值來做為信度的

指標。因此像是以皮爾森積差相關來處

理兩次測量的分數，將所得到的係數做

為再測信度，或是用我們這裡將要介紹

的 ICCR （ Intraclass Correlation 

Coefficient Reliability），都可以用來評估

的穩定度。 

在 One-way Random Effects Model

（以同一種工具評估所有病人）的假設

情況下，ICCR值可由下列公式計算： 

 

（公式 5）       

MSB：mean of between sum of square       

MSW：mean of within sum of square     

因為通常是比較兩個不同時間點

測量結果的一致性，所以 n0=2，目前尚

無法直接從 SAS 和 SPSS 下指令計算

ICCR，但是可先進行 ANOVA運算，得

到公式5中所需要的MSB和MSW數值

後，再代入公式計算ICCR值。而在ICCR

值的判讀上，<0.40為信度不佳，0.4-0.75

之間良好，>0.75極佳。 

結語 

本文中我們介紹了三種常用的信

度指標，相對於沒有提到的折半信度、

複本信度等，這三種指標都有計算簡

便、容易實行、限制較少的特點。然而

信度要達到多高才能被接受呢？這是一

個不易回答的問題，主要因為研究者的

需要不同，很難訂定一個適用於全部狀

況的單一標準。 

測量工具本身、受測樣本的變異

性、施測者、施測環境等等因素，都會

影響信度的高低，大致而言，一般認為

信度係數達 0.4 以上屬於良好，要達到

0.8以上才算極佳，但是為了要將信度從

0.4 提高到 0.8，可能需要花費許多的時

間與金錢去嘗試，是否有其必要性，則

值得多方思考。 

理想的測量應具備良好的信度和

效度，藉由信度和效度的高低，研究者

可以對該次測量的品質加以分析，由於

目前已經發展的信度測量方式有許多

種，我們在呈現研究結果時，應詳細說

明測量信度的方式並列出結果，而讓其

他研究者依其特定目的來決定信度是否

足夠，並據此判斷如何使用資料。 
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資料釋出使用狀況 
邱亦秀

申請人次 

    中央研究院調查研究工作室「學術調查研究資料庫」自成立至今，資料申請人次已達 3872

人次（有效數字至九十一年十一月底）。 

申請人身份方面，除了有 22筆資料不足無法辨別之外，共計大學院校教師 850人次；

研究人員 279人次；博、碩士班研究生 1966人次；大學生 473人次；助理 210人次，以及

其他（包括記者、醫師及經資料捐贈單位同意之人士等）85人次。 

    申請資料類型中，有 9筆資料不足無法判斷。其他共計「台灣地區社會變遷基本調查」

1694人次；「台灣地區社會意向調查」471人次；「政治大學選舉研究中心計畫2」267人次；

「台灣大學選舉相關之研究計畫3」60人次；「國科會 87年度調查研究計畫4」364人次；「國

科會 88年度調查研究計畫5」325人次；「國科會 89年度調查研究計畫6」23人次；「調研室

協辦計畫」121人次；「學者捐贈計畫」285人次；「第一次國民營養健康狀況變遷調查7」207

人次；「華人家庭動態資料庫的建立8」46人次。 

 

諮詢人次 

    使用者詢問有關資料釋出相關問題、檔案使用方式、程式語法等，經由專人解答之後，

即為資料庫處理的「諮詢」項目。 

 

 

 

 

 

                                                 
2 「政治大學選舉研究中心計畫」，民國八十七年十一月起開放釋出 
3 「台灣大學選舉相關之研究計畫」，民國九十年十月起開放釋出 
4 「國科會 87年度調查研究計畫」，民國八十八年六月起陸續開放釋出 
5 「國科會 88年度調查研究計畫」，民國八十九年六月起陸續開放釋出 
6 「國科會 89年度調查研究計畫」，民國九十一年六月起陸續開放釋出 
7 「第一次國民營養健康狀況變遷調查」，民國九十年四月起開放釋出 
8 「華人家庭動態資料庫的建立」第一年至第三年，民國九十一年七月起開放釋出 

累計諮詢人次

699 888 912 925 947 991 1019

84-90年12月 91年1月-6月 91年7月 91年8月 91年9月 91年10月 91年11月
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如何申請資料

一、資料使用者申請資格 

1. 國內外公私立研究機構之研究人員 

2. 國內外公私立大專院校之教師 

3. 國內外公私立大專院校博、碩士班研究生，及在老師指導下的大學部學生 

4. 政府機構之相關研究人員 

5. 捐贈或授權資料予學術調查研究資料庫之個人或機構 

6. 其他，視各捐贈資料者之要求另訂定之 

二、資料申請手續 

目前，我們所提供的資料申請方式共有兩種：網路申請及親自至「學術調查研究資料庫」申請。 

您可先以電話(02-27884188分機 209)、傳真(02-27881740)、或利用電子郵件(srda@gate.sinica.edu.tw)

與「學術調查研究資料庫」聯絡，詢問有關事項。同時，您也可透過本室在全球資訊網（WWW）的首

頁，獲得「學術調查研究資料庫」所有相關的資訊，網址為 http://www.sinica.edu.tw/as/survey。目前已可

利用WWW，直接在線上填妥申請表傳回「學術調查研究資料庫」。 

三、資料提供方式 

本資料庫以光碟、磁片、檔案傳遞或書面影本方式提供資料。 

四、資料工本費  

「學術調查研究資料庫」根據申請者的合理需求，提供拷貝電腦資料檔、資料庫收藏目錄等服務，

並酌收工本費。費用包括： 

1. 磁片與光碟片工本費：目前每一片1.44MB磁片20元，光碟片50元。 

2. 影印費：每張1元，申請者可以親自前來「學術調查研究資料庫」影印執行報告等書面資料；惟

行政院國家科學委員會專題研究計畫之調查資料，影印費用為每張3元。 

3. 郵電費：依資料使用者指定之郵寄方式所需郵資收費，以及劃撥手續費10至15元不等。 

4. 其他：未列入前述三項費用之必要費用。 

捐贈資料說明  
「學術調查研究資料庫」歡迎學者及各界捐贈資料，為使這些得來不易的珍貴資料發揮最大效用，

資料庫工作人員會謹慎處理每筆捐贈資料，並負起妥善保管之責。我們蒐集的資料主要是以調查方法進

行的量化資料，且該筆資料已經取得智慧財產所有人公開釋出之允許。 

「學術調查研究資料庫」對資料捐贈者提供以下服務項目： 

1. 定期/不定期寄送「學術調查研究資料庫」出版品。 

2. 資料整理與檢誤相關諮詢服務。 

3. 提供其所捐贈資料之申請情況。 

4. 提供資料使用者利用其所捐贈資料發表之衍生著作。 

如果您願意捐贈資料給「學術調查研究資料庫」蒐藏並對外開放，或您有任何疑問，歡迎洽詢「中

央研究院調查研究工作室」資料組組長王文心小姐 (電話：02-27884188 分機 201，或請 e-mail: 

srda@gate.sinica.edu.tw)，我們會竭誠為您服務。 



 

 
 

徵稿啟事 

「『學術調查研究資料庫』通訊」為中央研究院調查研究工作室發行服務學術界

之刊物，發行日期為四月份、八月份及十二月份。本室為增加本通訊內容之多樣性

及促進與讀者的互動交流，歡迎學界人士能夠提供以下相關議題之文章。

一、 二手資料之利用與分析 

二、 調查資料之整理與檢誤 

三、 國內外資料庫使用之經驗 

四、 資料編碼或編碼簿之製作 

五、 統計軟體之運用 

寫作重點請著重於經驗交流與心得建議。請以稿紙、磁片或 e-mail的方式傳寄

給我們，字數以 1000-1500 字為限，並以單篇完結之形式寫作。一經採用將稿費酬

謝，每千字 750元。文章以真實姓名發表，投稿請附上您的聯絡方法（通訊地址與

電話），本刊無法提供退稿服務。 

 

『學術調查研究資料庫』通訊 
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